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1 Foreword

1.1 Notes on the documentation

This description is only intended for the use of trained specialists in control and automation engineering who
are familiar with applicable national standards.

It is essential that the documentation and the following notes and explanations are followed when installing
and commissioning the components.

It is the duty of the technical personnel to use the documentation published at the respective time of each
installation and commissioning.

The responsible staff must ensure that the application or use of the products described satisfy all the
requirements for safety, including all the relevant laws, regulations, guidelines and standards.

Disclaimer

The documentation has been prepared with care. The products described are, however, constantly under
development.

We reserve the right to revise and change the documentation at any time and without prior announcement.
No claims for the modification of products that have already been supplied may be made on the basis of the
data, diagrams and descriptions in this documentation.

Trademarks

Beckhoff®, TwinCAT®, TwinCAT/BSD®, TC/BSD®, EtherCAT®, EtherCAT G®, EtherCAT G10°, EtherCAT P,
Safety over EtherCAT®, TwinSAFE®, XFC®, XTS® and XPlanar® are registered trademarks of and licensed by
Beckhoff Automation GmbH.

Other designations used in this publication may be trademarks whose use by third parties for their own
purposes could violate the rights of the owners.

Patent Pending

The EtherCAT Technology is covered, including but not limited to the following patent applications and
patents:

EP1590927, EP1789857, EP1456722, EP2137893, DE102015105702

with corresponding applications or registrations in various other countries.

—
EtherCAT.

EtherCAT® is a registered trademark and patented technology, licensed by Beckhoff Automation GmbH,
Germany

Copyright

© Beckhoff Automation GmbH & Co. KG, Germany.

The reproduction, distribution and utilization of this document as well as the communication of its contents to
others without express authorization are prohibited.

Offenders will be held liable for the payment of damages. All rights reserved in the event of the grant of a
patent, utility model or design.

TwinCAT 3 Version: 1.17 7
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1.2 Safety instructions

Safety regulations

Please note the following safety instructions and explanations!
Product-specific safety instructions can be found on following pages or in the areas mounting, wiring,
commissioning etc.

Exclusion of liability

All the components are supplied in particular hardware and software configurations appropriate for the
application. Modifications to hardware or software configurations other than those described in the
documentation are not permitted, and nullify the liability of Beckhoff Automation GmbH & Co. KG.
Personnel qualification

This description is only intended for trained specialists in control, automation and drive engineering who are
familiar with the applicable national standards.

Description of symbols

In this documentation the following symbols are used with an accompanying safety instruction or note. The
safety instructions must be read carefully and followed without fail!

A DANGER

Serious risk of injury!

Failure to follow the safety instructions associated with this symbol directly endangers the life and health of
persons.

Risk of injury!

Failure to follow the safety instructions associated with this symbol endangers the life and health of per-
sons.

A CAUTION

Personal injuries!
Failure to follow the safety instructions associated with this symbol can lead to injuries to persons.

NOTE

Damage to the environment or devices

Failure to follow the instructions associated with this symbol can lead to damage to the environment or
equipment.

® Tip or pointer
1 This symbol indicates information that contributes to better understanding.

Version: 1.17 TwinCAT 3
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1.3 Notes on information security

The products of Beckhoff Automation GmbH & Co. KG (Beckhoff), insofar as they can be accessed online,
are equipped with security functions that support the secure operation of plants, systems, machines and
networks. Despite the security functions, the creation, implementation and constant updating of a holistic
security concept for the operation are necessary to protect the respective plant, system, machine and
networks against cyber threats. The products sold by Beckhoff are only part of the overall security concept.
The customer is responsible for preventing unauthorized access by third parties to its equipment, systems,
machines and networks. The latter should be connected to the corporate network or the Internet only if
appropriate protective measures have been set up.

In addition, the recommendations from Beckhoff regarding appropriate protective measures should be
observed. Further information regarding information security and industrial security can be found in our

https://www.beckhoff.com/secquide.

Beckhoff products and solutions undergo continuous further development. This also applies to security
functions. In light of this continuous further development, Beckhoff expressly recommends that the products
are kept up to date at all times and that updates are installed for the products once they have been made
available. Using outdated or unsupported product versions can increase the risk of cyber threats.

To stay informed about information security for Beckhoff products, subscribe to the RSS feed at https://
www.beckhoff.com/secinfo.

TwinCAT 3 Version: 1.17 9
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2

Overview

This chapter is all about TwinCAT 3 implementation in C/C++. The most important chapters are:

Start from scratch
Which platforms are supported? Additional installations to implement TwinCAT 3 C++ modules?

Find all answers in Requirements [P _19] and Preparation [P 20]. Limitations are documented here
[»_156].

Quick start [» 62]

This is a “less than five minutes sample” to create a simple incrementing counter in C++ being
executed cyclically. Counter value will be monitored and overwritten, debugging capabilities will be
presented etc.

MODULES [» 37]

Modularization the basic philosophy of TwinCAT 3. Especially for C++ Modules it is required to
understand the module concept of TwinCAT 3.

Minimum is to read one article about the architecture of TwinCAT modules.

Wizards [» 89]

Documentation of visual components of the TwinCAT C++ environment.

This includes on the one hand tools for creating projects and on the other hand tools for editing module
and configuring instances of modules.

Programming Reference [P_146]

This chapter contains detailed information for programming in TwinCAT C++. For Example Interfaces
as well as other TwinCAT provided functions for ADS communication and helper methods are located
here.

The How to ...? [p 223] Chapter contains useful hints while working with TwinCAT C++.

Samples
Some Interfaces and their usage is best described by working code, which is provided as download
including source code and solution.

10
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BEGKHOFF Introduction

3 Introduction

The method of emulating classic automation devices such as programmable logic controllers (PLC) and
numerical controllers (NC) as software on powerful standard hardware has been the state of the art for many
years and is now practiced by many manufacturers.

There are many benefits, but the most important is without doubt the fact that the software is mostly
hardware-independent. This means, firstly, that the performance of the hardware can be specially adapted to
the application and, secondly, that you can automatically benefit from its further development.

This particularly applies to PC hardware, whose performance is still increasingly at a dramatically fast rate.
The relative independence from a supplier that results from this separation of software and hardware is also
very important for the user.

Since the PLC and Motion Control — and possibly other automation components — remain independent logic
function blocks with this method, there are only a few changes in the application architecture in comparison
with classic automation technology.

The PLC determines the machine's logical processes and transfers the implementation of certain axis
functions to the Motion Control. On account of the improved performance of the controllers and the
possibility to use higher-level programming languages (IEC 61131-3), even complex machines can be
automated in this way.

Modularization

In order to master the complexity of modern machines and at the same time to reduce the necessary
engineering expenditure, many machine manufacturers have begun to modularize their machines. Individual
functions, assemblies or machine units are thereby regarded as modules, which are as independent as
possible and are embedded into the overall system via uniform interfaces.

Ideally a machine is then structured hierarchically, whereby the lowest modules represent the simplest,
continually reusable basic elements. Joined together they form increasingly complex machine units, up to the
highest level where the entire machine is created. Different approaches are followed when it comes to the
control system aspects of machine modularization. These can be roughly divided into a decentralized and a
centralized approach.

In the local approach, each machine module is given its own controller, which determines the PLC functions
and possibly also the motion functions of the module.

The individual modules can be put into operation and maintained separately from one another and scaled
relatively independently. The necessary interactions between the controllers are coordinated via
communication networks (fieldbuses or Ethernet) and standardized via appropriate profiles.

The central approach concentrates all control functions of all modules in the common controller and uses
only very little pre-processing intelligence in the local I/O devices. The interactions can occur much more
directly within the central control unit, as the communication paths become much shorter. Dead times do not
occur and use of the control hardware is much more balanced, which reduces overall costs.

However, the central method also has the disadvantage that the necessary modularization of the control
software is not automatically specified. At the same time, the possibility of being able to access any
information from other parts of the program in the central controller obstructs the module formation and the
reusability of this control software in other applications. Since no communication channel exists between the
control units, an appropriate profile formation and standardization of the control units frequently fall by the
wayside.

The best of both worlds

The ideal controller for modular machines uses elements from decentralized and centralized control
architecture. A central, powerful computer platform of the most general kind possible serves 'as always' as
the control hardware.

The benefits of centralized control technology:

e low overall costs
* available

TwinCAT 3 Version: 1.17 11
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« fast, modular fieldbus system (keyword: EtherCAT)
+ and the possibility to access all information in the system without loss of communication

are decisive arguments.

The above-mentioned benefits of a decentralized approach can be implemented in the centralized control
system by means of suitable modularization of the control software.

Instead of allowing a large, complex PLC program and an NC with many axes to run, many small ‘controllers’
can co-exist in a common runtime on the same hardware with relative independence from one another. The
individual control modules are self-contained and make their functions available to the environment via
standard interfaces, or they use corresponding functions of other modules or the runtime.

A significant profile is created through the definition of these interfaces and the standardization of the
corresponding parameters and process data. Since the individual modules are implemented in a runtime,
direct calls of other modules are also possible — once again via corresponding standard interfaces. In this
way the modularization can take place within sensible limits without communication losses occurring.

During the development or commissioning of individual machine modules, the associated control modules
can be created and tested on any control hardware with the appropriate runtime. Missing connections to
other modules can be emulated during this phase. On the complete machine they are then instanced
together on the central runtime, which only needs to be dimensioned such that the resource requirements of
all instanced modules (memory, tasks and computing power) are fulfilled.

TwinCAT 3 runtime

TwinCAT Runtime offers a software environment in which the TwinCAT modules are loaded, implemented
and managed. It provides more basic functions so that system resources (memory, tasks, fieldbus and
hardware access, etc.) can be used. The individual modules must not have been created with the same
compiler. This means that they can be independent of each other and come from different suppliers.

When the runtime starts, some system modules are automatically loaded so that their properties are
available to other modules. However, the properties of the system modules are accessed in the same way
as the properties of normal modules, so it does not matter to the modules whether the respective property is
provided by a system module or a normal module.
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OS User-Mode Libraries

User Mode

Kernel Mode

TwinCAT PLC

TwinCAT C++

OS Kernel-Mode Libraries

Unlike the PLC, where the user-defined program is executed in a runtime environment, TwinCAT C++
modules are not in such a hosted environment. This causes TwinCAT C++ modules (.tmx) to be executed as
kernel modules, which are loaded by TwinCAT.

3.1 From conventional user mode programming to real-
time programming in TwinCAT

This article describes the conceptual differences between standard user mode programming in a
programming language such as C++, C# or Java, and real-time programming in TwinCAT.

The article particularly focuses on real-time programming with TwinCAT C++, because this is where previous
knowledge with C++ programming comes to the fore and the sequence characteristics of the TwinCAT real-
time system have to be taken into account.
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Program

Program does
not recognize
interruption

Continue

With conventional user mode programming, e.g. in C#, a program is created, which is then executed by an
operating system.

The program is started by the operating system and can run independently, i.e. it has full control over its own
execution, including aspects such as threading and memory management. In order to enable multitasking,
the operating system interrupts such a program at any time and for any period. The program does not
register such an interruption. The operating system must ensure that such interruptions remain unnoticed by
the user. The data exchange between the program and its environment is event-driven, i.e. non-deterministic
and often blocking.
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The behavior is not adequate for execution under real-time conditions, because the application itself must be
able to rely on the available resources in order to be able to ensure real-time characteristics (response
guarantees).

TwinCAT
TwinCAT XAR

TcCOM
Module

Task

CycleUpdate()

[}
£
=
i
o
>
Q

CycleUpdate()

Cycletime

CycleUpdate()

CycleUpdate()
is called
cyclically

The basic idea of PLC is therefore adopted for TwWinCAT C++: the TwinCAT real-time system manages the
real-time tasks, handles the scheduling and cyclically calls an entry point in the program code. The program
execution must be completed within the available cycle length and return the control. The TwinCAT system
makes the data from the I/O area available in the process images, so that consistent access can be
guaranteed. This means that the program code itself cannot use mechanisms such as threading.
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Concurrency

Operating System
OS Scheduler

Program

Start

Start

Event-driven,
asynchronous

communication —

M"-"qu..

With conventional programming in user mode, concurrency is controlled by the program. This is where
threads are started, which communicate with each other. All these mechanisms require resources, which
have to be allocated and enabled, which can compromise the real-time capability. The communication
between the threads is event-based, so that a calling thread has no control over the processing time in the
called thread.

In TwinCAT, tasks are used for calling modules, which therefore represents concurrency. Tasks are
assigned to a core; they have cycle times and priorities, with the result that a higher-priority task can interrupt
a lower-priority task. If several cores are used, tasks are executed concurrently in practice.
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Context Context
Task 1 , Task 2

Modules can communicate with each other, so that data consistency has to be ensured in concurrency
mode.

Data exchange across task boundaries is enabled through mapping, for example. When direct data access
via methods is used, it must be protected through Critical sections, for example.

Startup/shutdown behavior

The TwinCAT C++ code is executed in the so-called "kernel context" and the "TwinCAT real-time context",
not as a user mode application.

During startup/shutdown of the modules, code for (de)initialization is initially executed in the kernel context;
only the last phase and the cyclic calls are executed in the TwinCAT real-time context.

Details are described in chapter Module state machine [P 44].

Memory management

TwinCAT has its own memory management, which can also be used in the real-time context. This memory is
obtained from what is referred to as the "non-paged pool", which is provided by the operating system. In this
memory the TcCOM modules are instantiated with their memory requirement.

In addition, the so-called "router memory" is provided by TwinCAT in this memory area, from which the
TcCOM modules can allocate memory dynamically in the real-time-context (e.g. with the New operator).
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TcAlloc

If possible, memory should generally be allocated in advance, not in the cyclic code. During each allocation a
check is required to verify that the memory is actually available. For allocations in the cyclic code, the
execution therefore depends on the memory availability.
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A Requirements

Overview of minimum requirements

The following minimum requirements must be met for the implementation and debugging of TwinCAT 3 C++
modules.

The following must be installed on the engineering PC:
* Microsoft Visual Studio 2017 or 2019 Professional / Enterprise.
o When installing Visual Studio, the Desktop development with C++ option must be additionally
selected, as this option is not selected with the automatic installation:

Installing — Visual Studio Professional 2019 — 16.7.0

Workloads Individual components Language packs Installation locations
P Python development {\] Node.js development
Editing, debugging, intertive development and source ) Build scalable network applications using Node.js, an

control for Python. asynchronous event-driven JavaScript runtime.

Desktop & Mobile (5)

.NET desktop development r b Desktop development with C++
'—.J Build WPF, Windows Forms, and console applications using Iﬂ.] Build modern C++ apps for Windows using tools of your
C#, Visual Basic, and F# with .NET Core and .NET... choice, including MSVC, Clang, CMake, or MSBuild.

Modifying — Visual Studio Professional 2017 — 15.6.6
Workloads Individual components Language packs

Windows (3)

m M Universal Windows Platform development m .NET desktop development
Hl Create applications for the Universal Windows Platform 'J Build WPF, Windows Forms, and console applications using
with C# VB, JavaScript, or optionally C++. C#, Vizual Basic, and F=

"‘I +J Desktop development with C++

Build Windows desktop applications using the Microsoft
C++ toolset, ATL, or MFC.

« TwinCAT 3 installation (XAE engineering)
» XaeShell is sufficient for the integration and use of existing binary C++ modules in a TwinCAT 3 PLC
environment (Visual Studio is not required).

On the runtime PC:

* |IPC or Embedded CX PC with one of the operating systems Windows 7 / 10 or TwinCAT/BSD. Both 32
and 64-bit versions are supported.

¢ Microsoft Visual Studio does not have to be installed.
» TwinCAT 3.1 installation (XAR runtime)
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5 Preparation - only once

A PC for the engineering of TwinCAT C++ modules must be prepared. You only have to carry out these
steps once:
» Configure the TwinCAT Basis [»_20] as well as the configuration and platform toolbar.

 Sign modules so that they can be executed; see Documentation for setting up a test signing [»_20].

5.1 Visual Studio - TwinCAT XAE Base toolbar

Efficient engineering through TwinCAT XAE base toolbar

TwinCAT 3 integrates its own toolbar in the Visual Studio menu for better efficiency. It assists you in the
creation of C++ projects. This toolbar is automatically added to the Visual Studio menu by the TwinCAT 3
setup. If you wish to add it manually, however, do the following:

1. Open the View menu and select Toolbars\TwinCAT XAE Base
= The selected toolbar appears below the menu.

D'd TwinCAT I0-Project - Microsoft Visual Studio (Administrator)

File  Edit View Project Build Debug TwinCAT  TwinSAFE PLC  Team  Tools Test Scope  Analyze Win

C0-0 B 0-2 WX - | Release ~| TwinCAT RT (x54) - B Attach.. -
‘nE B2 @ @I <o - L |

Solui®n Explorer

L |
"

(a) | -5 & | p Untitledl « = CModulel
h - - : [
Sean™ Solution Explorer (Ctrl+) ol LRESULT hr = 5.0;
fad Siclution TwinCAT I0-Project’ (1 project) m_Trace.Log(tlVerbose, FENTERA};
4 ai[] TwinCAT 10-Project
' ﬂ SYSTEM /f TODO: Add deinitialization code
MOTION m_Trace.Log(tlVerbose, FLEAVEA "hr=8x%38x", hr
PLC return hr;
5.2 Driver signing

TwinCAT C++ modules must be signed with a certificate so that they can be executed.

The signature ensures that only C++ software whose origin can be traced is executed on productive
systems.

For test purposes, certificates that cannot be verified can be used for signing. However, this is only possible
if the operating system is in test mode so that these certificates are not used on productive systems.

® Engineering requires no signing
1 Only the execution requires certificates - the engineering does not.

There are two ways to load modules. For this purpose, different certificates are used for signing:

* TwinCAT: the C++ modules are loaded by the TwinCAT runtime system and must be signed with a
TwinCAT user certificate.

o With TwinCAT 3.1. 4024 and higher, this procedure is also available.

o This procedure is required to perform new functions such as Versioned C++ Projects [P 49] and
thus also the Online Change [»_155].

> Required for TwinCAT/BSD.
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» (For <4024.0, no longer recommended for new projects. Existing projects should be migrated)
Operating system: the C++ modules are loaded as normal kernel drivers and must therefore also have
a signature.

o With TwinCAT 3.1. 4022 or earlier, only this procedure is available.
o Windows 7 (Embedded) x86 (32bit) does not require signing.
o Cannot be used with TwinCAT/BSD.

Since a published module should be executable on various PCs, signing is always necessary for publishing.

Organizational separation of development and production software
Beckhoff recommends working organizationally with (at least) two certificates.

1. A certificate which is not countersigned, thus the test mode is needed for the development process.
This certificate can also be issued individually by each developer.

2. Only the software that has passed the corresponding final tests is signed by a countersigned certifi-
cate. This software can thus also be installed on machines and delivered.

Such a separation of development and operation ensures that only tested software runs on productive
systems.

5.2.1 TwinCAT

Versioned C++ projects are stored as binary in a TMX file (TwinCAT Module Executeable).

For the implementation of TwinCAT 3 C++ modules, this compiled, executable TMX file must be signed with
a TwinCAT user certificate if it is to be loaded by the TwinCAT Runtime.

Signing

TwinCAT TMX files can only be loaded after a successful signing.

Signing on 32-bit and 64-bit systems

In contrast to the operating system signing, TwinCAT signing is intended for both 32-bit and 64-bit systems.
Thus, the test mode is also assumed for a test signing on 32-bit systems.

For signing a TMX file, a TwinCAT user certificate is required [P 21], which is configured accordingly in the
project for signing [»_151].

Test signing

The user certificate can be created locally in TwinCAT. As long as it is not countersigned by Beckhoff, it is
necessary to activate the test mode, as described here [P 21].

As soon as the TwinCAT user certificate has been countersigned by Beckhoff [P 24], the test mode can be
dispensed with accordingly. It can be deactivated in the same way as it is activated.

Also see about this
TwinCAT Loader [ 54]

5.211 Test signing

The test signing for TWinCAT can be carried out with the same TwinCAT user certificate as for the actual
delivery (see Request TwinCAT 3 user certificate [P 24]).
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1. For test operation, e.g. during software development, the creation of a TwinCAT user certificate, as
described Creation of the Certificate Request file for TCO008 [P 25], is sufficient. Make sure that you

select the purpose "Sign TwinCAT C++ executable (*.tmx)". For this the Crypto version 2 is required, a
message appears.

are Frotection X

Certificates Database Users Groups Object Protection  Fights

MName Unique Status Issue (UTC) Expire (UTC) Permissions
Create OEM Certificate *
OEM Mame: il
. | ; ] ] | Cancel
OEM Certfficatt  Unique Mame [domain or e-mail address):
Create New.] | |
Import ... ] Certifizate for:

Sign user DB
Sign OEM licensze request
OEM Authaority Sign TwinCAT C++ executable [* )

Sign License

Create Temp*

Creste How q e Vel Microsoft Visual Studio

Reissue E:rjst‘

OEM certificate for TwinCAT C++ executable signing must use crypto
version 2 which is supported by TwinCAT 3.1.4024 and newer, Change
crypto version?

oK | Cancel

On XAR (and XAE, ifitis a local test), activate the test mode so that the operating system can accept the
self-signed certificates. This can be done on both engineering systems (XAE) and runtime systems (XAR).

For Windows

Use the administrator prompt to execute the following:

bcdedit /set testsigning yes

and reboot the target system.

You may have to switch off "SecureBoot" for this, which can be done in the bios.

If test signing mode is enabled, this is displayed at the bottom right of the desktop. The system now accepts
all signed drivers for execution.

Test Mode
Windows 10 Enterprise

Build 19041.vb_release.191206-1406
10:55 AM
10/15/2021
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For TwinCAT/BSD

In the file /usr/local/etc/TwinCAT/3.1/TcRegistry.xml enter ,<Value
Name="EnableTestSigning" Type="DW">1</Value>"under Key "System".
<Key Name="System">

<Value Name="RunAsDevice" Type="DW">1</Value>

<Value Name="RTimeMode" Type="DW">0</Value>

<Value Name="AmsNetId" Type="BIN">052445B00101</Value>

<Value Name="LockedMemSize" Type="DW">33554432</Value>

<Value Name="EnableTestSigning" Type="DW">1</Value>
</Key>

Then restart the TwinCAT System Service:
doas service TcSystemService restart

After the respective procedure, the system accepts all signed drivers for execution.

2. During the first activation (Activate Configuration) with a TwinCAT user certificate, the target system
detects that the certificate is not trusted and the activation process is aborted:

Error List
Entire Solution - ||@ 2 Errors H| 1 4Warnings |||0 18 Messages H Clear | | Build + IntelliSense -
Code  Description
) 27.08.2019 17:32:42 783 ms | "TwinCAT System' (10000): Sending ams command »> InitT\Load Driver: Load Versioned Classfactory 'C++ Module Vendor|Untitled1]0.0.0.1" = » AdsError:
ERROR: General ADS Error) << failed!
[x] 27.08.2019 17:32:42 782 ms | 'TCOM Server' (10): Loading 'CA\TwinCAT\3.1\Boot\Repositon\ C++ Module Vendor\Untitled 140.0.0.1\Untitled1.trmx' failed
27.08.2019 17:32:42 782 ms | TCOM Ek’ver' (10 Impert 'C\TwinCAT\3. 1\ Target\OemCertificates\test.domain_db006e5e-e160-0177-d83e-2f0ddafdacfe.reg’ to add OEM to trusted list
For Windows:
A local user with administration rights can trust the certificate via the created REG file by simply
executing it:

» ThisPC » Systern (C:) » TwinCAT » 3.1 » Target » OemCertificates

[ Mame Date modified Type Size

@ test.domain_db006e5e-e160-0177-d83e-2... 27.08.201917:32 Registration Entries 2 KB

o The keys and values contained in
CATwinCAT\3. T\ Target\ QemCertif...\test. domain_db006e3e-e160-0177-d33e-2f0d dafdaefe.reg
have been successfully added to the registry.

For TwinCAT/BSD:
If the "Tcimportcert" package is not installed, install it: pkg install tcimportcert
Trust the certificate via doas tcimportcert /usr/local/etc/TwinCAT/3.1/Target/
OemCertificates/<CreatedFile>.reg
Then restart the TwinCAT System Service or reboot the system:
doas service TcSystemService restart
= This process only enables C++ modules with a signature from the trusted TwinCAT user certificates
to run.
3. Following this process you can use the TwinCAT user certificate for signing with the test mode of the
operating system.
This is configured in the project properties [P_151].
Use the TcSignTool [P 59] to avoid storing the password of the TwinCAT user certificate in the project,
where it would also end up in version management, for example.

If you want to use the TwinCAT user certificate without TestMode for delivery, you must have the certificate
countersigned by Beckhoff [»_24].
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5.21.2 Signed TwinCAT user certificates for delivery without test mode

® System requirements

1 - Min. TwinCAT 3.1 Build 4024
- Min. Windows 10 or TwinCAT/BSD (on the target system)

With TwinCAT Build 4024, Beckhoff offers existing customers the issuing of a "TwinCAT 3 OEM user
certificate", which can be used for signing TMX files created with TwinCAT 3 in C++.

+ This certificate requires secure validation of the applicant data, since it is used in the Windows
environment. TwinCAT 3 user certificates must therefore be officially ordered for validation of the
address and contact data, and are only issued to existing Beckhoff customers.

* Order number: TC0008
» The issuing of this TwinCAT 3 user certificate is free of charge.
 Directory for saving the certificate: C:\TwinCAT\3.1\CustomConfig\Certificates

The TwinCAT 3 user certificate is not required for using the TwinCAT 3 TMX files

The TwinCAT 3 user certificate is used exclusively for the one-time signing of the TMX files and is
not required for the use of the TMX files signed with it.

i o

On which computers is the TwinCAT 3 user certificate TC0008 required?

The TwinCAT 3 user certificate should be located exclusively on the engineering computer on which
the TMX files are signed - i.e. NOT on each target system.

jio

Validity of the TwinCAT 3 user certificate

The validity of the TwinCAT 3 user certificate is limited to two years for security reasons.

® What happens if the certificate has expired?

You can no longer sign new TMX files.
However, the use of already signed TMX files is still possible without any restrictions.

You can apply for a renewal of your certificate before the expiry of the two years (and even after that).

To extend a TwinCAT 3 user certificate, the same process applies as for requesting a new certificate. In this
case, the certificate must also be ordered (the order numbers for a certificate extension are the same as for
a new certificate request).

In contrast to a new certificate, you do not generate a new OEM Certificate Request File but send your
existing certificate to the Beckhoff certificate section for renewal. Please notify us in the email that this is a
certificate extension and not a new issue. Otherwise, the same criteria apply regarding the content of the
email as for the application for a new certificate.

The existing certificate receives a new expiration date, is then re-signed and is valid for another 2 years.

The newly signed certificate is thus fully compatible with the original version.

5.21.21 Request TwinCAT 3 user certificate

Overview of the ordering and validation process

An official order is required to request a TwinCAT user certificate.
* Order number: TC0008 (TwinCAT 3 Certificate Extended Validation)
» The issuing (and renewal) of a TwinCAT 3 user certificate is free of charge.

» Since a TwinCAT 3 user certificate is a digital ID card, verification of the inquirer's contact data is
required according to the usual market standards.
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» A TwinCAT 3 user certificate is therefore only issued to existing Beckhoff customers.

Overview of the ordering and validation process

@ Your email address must be a company email account (freemailers such as GMail or similar are not
1 permitted) and correspond with the company name of the inquirer.

1.

2.

Contact your Beckhoff sales contact and announce the request of a TwinCAT 3 OEM certificate. Order
"TC0007" or "TC0008".

Important: as the inquirer, please provide your contact details as the delivery address (= contact name
and email address) and the area of use of the certificate (company name, address).

. The contact details provided in the order will be verified and you (the inquirer named in the delivery

address) will be contacted by Beckhoff Sales.

4. When requesting a new OEM certificate, Creation of the Certificate Request file for TC0008 [P 25].

. Determine the "File Fingerprint" of the OEM certificate file using TwinCAT Engineering (see Determin-

ing the file fingerprint of the OEM certificate file [P_28]). Please inform the Beckhoff sales contact of
this File Fingerprint as part of your contact data verification. The transmission of the File Fingerprint
must be done by a different communication channel than the one used for sending the OEM certificate
request file.

Now send the "OEM certificate file" to the Beckhoff sales contact.

. After signing the certificate file at the Beckhoff headquarters, you will receive it by e-mail from your

contact person.

Please note that it may take a few days to validate your contact details and issue the certificate.

5.2.1.2.2 Creation of the Certificate Request file for TC0008

® System requirements

1

- Min. TwinCAT 3.1 Build 4024
- Min. Windows 10 or TwinCAT/BSD (on the target system)

Call up the Software Protection configurator. To do this, select the menu item Software Protection in the
main menu below the item TwinCAT:

ﬂ Microsoft Yisual Studio

File

Edit View Project Debug| TwinCAT | TwinSAFE  PLC

. - | i3 - -2 e Windows ¥

= 3| |E # iz | & Software Protection...
File Handling ]

EtherCAT Devices K

About TwinCAT

In the window that opens, select the Certificates tab.
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0 >
Cerfficates  Database Users Groups Object Protection  Rights
MName Inique Status lzsue (UTC) Expire (UTC)
OEM CEI‘ti‘fiCEI‘tE D E:d:EI'ldEd ||-|f|3|
Create Mew...
Impart ...
QK Abbrechen
The Create OEM Certificate input window opens:
Software Protection >
Cerfficates Database Users Groups Object Protection  Fights
Mame Inique Status lzsue (UTC)

Create OEM Certificate >

QEM Mame: Start

“ | Cancel

OEM Certificat! Unigue M ame [domain or e-mail address];

Create Newi | |
Import ... 1 Certificate for:

Sign uzer DB

Sign OEM licenze request

[ ]5ign TwinCAT C++ executable [*.trw)

Crypto ersion: 2 e

QK Abbrechen

1. Enter the required data:

» Enter your company name in the OEM Name text box. The name must have a clear reference to your
company or your business unit.
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» Enter a Unique Name. The "OEM Unique Name" must be a unique name that uniquely identifies the
owner of the certificate worldwide, preferably the URL of your company's website or your email
address. The email address must be a company email address, i.e. it must be possible to assign it
unambiguously to your company.

* Check the checkbox "Sign TwinCAT C++ executables:

Cerificates Database Users Groups Object Protection Rights

Name Unique Status lssue (UTC)

Create OEM Certificate X

DEM Name:

BN |

OEM Certificat{ Unique Name [domain or e-mail address): Cencel
e | 1

Start

Import ... Certificate for:

(] Sign user DB
[ 1Sign OEM license request
/] Sign TwinCAT C++ executable [".Erm:]]

Crypto Version: 2 v

OK Abbrechen

If you only want to sign TwinCAT driver software with this certificate, uncheck the other two
checkboxes. (These are only used in the PLC area)

» Make sure that Crypto version 2 (for the encrypted content of the certificate content) is set. (standard
setting)

2. Once you have entered the data, click Start and select a directory to save the file. Note: You can simply
accept the suggested directory "c:\twincat\3.1\customconfig\certificates". You need the newly created file

in this directory in order to be able to read out the file fingerprint for this file [> 28] in a subsequent step.
= A dialog for selecting a password for the OEM Private Key opens.
3. Issue a password for the OEM Private Key.

® Important: Password security!

1 Be sure to use a strong password for your certificate!
Protect your password with suitable measures so that it cannot fall into unauthorized hands!

Password cannot be restored if lost

o
1 Beckhoff is unable to recover or reset your password. If you forget or lose the password for your
certificate, you can no longer use it and have to request a new certificate.
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4. Confirm the password by entering it again and close the dialog with OK.

Enter encryption password to protect private key X
Password: | sesssessessssese | Cancel
Verify: | sosescsseecseses |

= The file is saved.

The "Certificate Request File" generated in this way must now be signed by the Beckhoff certificate section
in order to be valid. The procedure is described in chapter Requesting a certificate [P 24].

5.21.2.3 Determining the file fingerprint of the OEM certificate file

You need this functionality to request a TwinCAT OEM Certificate Extended Validation (TC0008).

® System requirements
1 This functionality requires TwinCAT 3.1 build 4024 of higher.

® Note for "OEM Certificate Request File"

1 The "OEM Certificate Request File" becomes the TwinCAT OEM certificate once it is signed by
Beckhoff. The files do not differ except for this signature. For this reason, the term "TwinCAT OEM
certificate file" is used for both file versions in the following sections.

Reading the “file fingerprint" of an OEM certificate file via TwinCAT 3 Engineering

For this function it is necessary that the OEM certificate file is located in this directory: "c:
\twincat\3.1\customconfig\certificates".

Notes:
 This directory contains your OEM certificate, if you already have a certificate and want to renew it.

« If you did not change the suggested directory when creating the "OEM Certificate Request File", the file
is already in this directory.

Procedure:
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1. Call up the TwinCAT 3 Software Protection configurator

E‘QJ Start Page - Microsoft Visual Studic

File  Edit VWiew | TwinCAT | TwinSAFE PLC  Te:
- = | #3 «| & Software Protection...
Chaage Active User...

| Solution Explorer Show ‘ealtime Ethernet...

| ﬁ Filel Sz ware Protection
Ethi =
| Cerificates |Database Users Groups Object Protection  Rights
@l TP
Tar Demld Fingerprint h
Filk 4-7FeRARAA. TBBH A4FT-BBDD-53AF-FS67-667 F&W—ER&'I-ABDEJ
Abg :
E
< ," >
- -'-F- "
QEM Cerificate |Extended Info
Create Mew...
Import ..

2. Select the "Certificates" tab
3. Check the "Extended Info" box
4. In the window scroll to the right until you see the Fingerprint column

Note: As an alternative to points 3 + 4, you can simply double-click the certificate line. The file fingerprint is
then displayed in a pop-up window:

OEM Certificate 'Beckhoff_2' has fingerprint
‘A231-B8535-33AF-FO66-6ETF-24F7-22D0 - AAAG

oK

Note: The shortcut Ctrl + C can be used to copy the fingerprint data from the message window to the
Windows clipboard.

5.21.24 Saving the signed TwinCAT user certificate

Recommended directory for saving the certificate: C:\TwinCAT\3.1\CustomConfig\Certificates

® System requirements

1 - Min. TwinCAT 3.1 Build 4024
- Min. Windows 10 or TwinCAT/BSD (on the target system)
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The TwinCAT 3 user certificate is not required for using the TwinCAT 3 TMX files

o
1 The TwinCAT 3 user certificate is used exclusively for the one-time signing of the TMX files and is
not required for the use of the TMX files signed with it.

On which computers is the TwinCAT 3 user certificate TC0008 required?

o
1 The TwinCAT 3 user certificate should be located exclusively on the engineering computer on which
the TMX files are signed - i.e. NOT on each target system.

5.2.2 Operating system

Migration to TMX with TwinCAT Loader recommended

Since TwinCAT 3.1 4024.0 versioned C++ projects are available, whose binaries can be loaded directly
from TwinCAT. Migration is recommended!

For the implementation of TwinCAT 3 C++ modules on x64 platforms, the driver (*.sys file) must be signed
with a certificate if it is to be loaded by the operating system.

The signature, which is automatically executed during the TwinCAT 3 build process, is used by 64-bit
Windows operating systems for the authentication of the drivers.

A certificate is required to sign a driver._This Microsoft documentation describes the process and
background knowledge for obtaining a test and release certificate that is accepted by 64-bit Windows
operating systems.

To use such a certificate in TwinCAT 3, configure the step after compiling your x64 build target as
documented in "Creating a test certificate for test mode [P 301"

Test certificates
For testing purposes, self-signed test certificates can be created and used without technical limitations.

The following tutorials describe how to enable this option.
To create drivers with real certificates for production machines, this option must be disabled.

» Creating a test certificate for test mode [» 30]
» Delete (test) certificates [P 32]

Further references:

MSDN, MakeCert test certificates (Windows drivers),
https://docs.microsoft.com/en-us/windows-hardware/drivers/install/makecert-test-certificate

5.2.21 Test signing

Overview
Implementing TwinCAT 3 C++ modules for x64 platforms requires signing the driver with a certificate.

This article describes how to create and install a test certificate for testing a C++ driver.

® Note the procedure when creating test certificates

Developers may have a wide range of tools for creating certificates. Please follow this description
exactly, in order to activate the test certificate mechanism.

The following commands must be executed from a command line that has been opened in either way:
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» Visual Studio 2010/ 2012 prompt with administrator rights. (Via: All Programs -> Microsoft
Visual Studio 2010/2012 -> Visual Studio Tools -> Visual Studio Command Prompt, then right-click
Run as administrator)

* Developer Command Prompt of Visual Studio 2017 / 2019 with administrator rights. (Via: All
Programs -> Visual Studio 2017 -> Visual Studio Command Prompt for VS 2017/2019, then right-
click on Run as administrator)

* Only if the WINDDK has been installed:
Normal prompt (Start ->Command Prompt) with administrator rights, then change to directory
%WINDDK7%\bin\x86\, which contains the corresponding tools.

1. On XAE:
in the engineering system enter the following command in the Visual Studio 2010 / 2012 prompt with
administrator rights (see note above):
makecert -r -pe -ss PrivateCertStore -n CN=MyTestSigningCert
MyTestSigningCert.cer
(If you do not have access rights to the PrivateCertStore, you can use a different location. This
must also be used in the PostBuild event, as described here [»_34].)

= This is followed by creation of a self-signed certificate, which is stored in the file
"MyTestSigningCert.cer" and in the Windows Certificate Store.

= Check the result with mmc (Use File->Add/Remove Snap-in->Certificates):

ﬁ certmgr - [Certificates - Current User\PrivateCertStore\Certificates

File Action View Help
«=|7nE =

EE_I“ Certificates - Current User Issued To = Issued By Expiration Date  Intended Purposes  Friendly Mar

[0 Persanal 2] MyTestSigningCert MyTestSigningCert  01.01.2040 <Alls <None>
» || Trusted Root Certification Authorities

» [ Other People
» [ ] PC-Doctor, Inc.
4 || PrivateCertStore
| Certificates
» [ Certificate Enrollment Requests
» || Smart Card Trusted Roots

2. On XAE:
configure the certificate so that it is recognized by TwinCAT XAE on the engineering system.
Set the environment variable TWINCATTESTCERTIFICATE to "MyTestSigningCert" in the engineering
system or edit the post build event of Debug|TwinCAT RT (x64) and Release|TwinCAT RT (x64).
The name of the variable is NOT the name of the certificate file, but the CN name (in this case
MyTestSigningCert).

m From TwinCAT 3.1 4024.0, the configuration of the certificate to be used is carried out under Tc

Sign in the project properties. To use signing via the operating system, as described here, please
pay attention to the project settings:

Untitled] Property Pages

Configuration: | Release | Platform: | Active(TwinCAT RT (xgd))
4 Configuration Properties * Enable signing

General 5HAT signing Yes
Debugging SHA256 =igning Mo
VC++ Directories TwinCAT signing Mo
Te DK w  TwinCAT Certificate (Same for all configurations)
B TwinCAT Certificate Name
Tc Uh“m TwinCAT Certificate Password

Verbose Qutput Ma
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On XAR (and XAE, if it is a local test), activate the test mode so that the operating system can accept the
self-signed certificates. This can be done on both engineering systems (XAE) and runtime systems (XAR).

For Windows

Use the administrator prompt to execute the following:

bcdedit /set testsigning yes

and reboot the target system.

You may have to switch off "SecureBoot" for this, which can be done in the bios.

If test signing mode is enabled, this is displayed at the bottom right of the desktop. The system now accepts
all signed drivers for execution.

Test Mode
Windows 10 Enterprise

Build 19041.vb_release.191206-1406
10:55 AM
10/15/2021

After the respective procedure, the system accepts all signed drivers for execution.

3. Test whether a configuration with a TwinCAT module implemented in a TwinCAT C++ driver can be
enabled and started on the target system.

= Compilation of the x64 driver generates the following output:

Show output from:  Build - £ a

1p==nm=- Build started: Project: Untitled2, Configuration: Debug TwinCAT RT (x64) ------

1> header file << C:\TwinCAT\3.I\SDK\\_products\TwinCAT RT (x64)\DebugiUntitled2\\Untitled2Version.h »> is up-to-date!
1> TcPch.cpp

1> Modulel.cpp

1» Untitled2ClassFactory.cpp

1> Untitled2Driver.cpp

1> Untitled2.vexproj -»> C:A\TwinCATA3.I\SDK\\_products\TwinCAT RT (x64)\Debug\Untitled2.sys
1> The following certificate was selected:

1> Issued to: MyTestSigningCert

1>

1s Issued by: MyTestSigningCert

1>

1> Expires: Sun Jan 81 @8:59:59 2844

1>

1> 5HA1 hash: E27ABBEBABCTECEC36DFDDE93DDF2I486D1EESB2ZE

1>

1>

1> Done Adding Additional Store

1> Successfully signed and timestamped: C:\TwinCAT\3.1\SDK%\_products\TwinCAT RT (x64)\Debug\Untitled2.sys
1>

1>

1> MNumber of files successfully Signed: 1

1>

1* MNumber of warnings: 8

1> MNumber of errors: @

References:
MSDN, MakeCert test certificates (Windows drivers),

https://docs.microsoft.com/en-us/windows-hardware/drivers/install/makecert-test-certificate

5.2.2.2 Delete test certificate

This article is about how to delete a test certificate.
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Overview

A certificate can be deleted with the Microsoft Management Console:
1. Start the management console MMC.exe via the Start menu or the user interface.

@ Fle Adion View Favontes Window Help o

|z BE

| Conscle Root Marme Acticns
Contale Root

More Actions

There are no iterms to show in this view,

2. Click in the menu on File -> Add/Remove Snap-in.. and select the certificate snap-in for the current
user; conclude with OK.

Yous can select snap-ns for thes console from those svadable on your computer and configure the selected set of snapns. For

extensible snap-ing, you can configure which extensions are enabled,

Available snap-ns: _ Selected snap-ins; ————— =
Snapn Vendor - | | Console Root Edit Extensions... |
Y NET Framework 2.0... Micosoft Cor... i Certificates - Current Liser

= ActiveX Control Microsoft Cor,.,

ﬁmﬂwﬁmmw Microsoft Cor... |

50 Certificates Microsoft Cor. .,

-"?-Emmmt&nm Microsoft Cor, .. =
;ﬁ_-cmwmrwm... Microsoft Cor... IT‘”’_J :

= Device Manager Micresoft Cor,.. =

H'Bi.dcl'-‘lmagﬂrmt Microsoft and...

[2] Event viawer Microsoft Cor,..

| Foider Microsoft Cor...

.._T"\YDLHJPﬂifrﬁhjttt... Microsoft Cor,..
aLPSeu.ntym"lmr Microsoft Cor, ..
| Brsnyricn. oo . i —

Description:
The Certificates snap-in alows you to browse the contents of the certficate stores for yourself, a service, or & computer.

I’ | ook || cance

= The certificates are listed in the node under PrivateCertStore/Certificates.
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3. Select the certificate to be deleted.

@ File Action Wiew Fmortes Window  Help e}
oo s 0= BE

Console Reot bssued To - legued By Espiration Date  Intended Pusposes Actions

a [F Certificates - Cumrent User
Personal
~ Trusted Root Cemification Authorities
Enterpnze Trust
Intermediate Certification Authosties
Active Directory User Object
| Trusted Pubhishers
Untrusted Centificates
~ Third-Party Root Certification Autharities
Trusted People
Qther People
& PrivateCenStone
* Certificates
Certificate Ensollrment Requests
| Semart Caed Trusted Raots

Col Beckhatf.comiTest) Beckhedl.com{Tem) 1/1/2080 <Al Centificates -
EaMyTestSegringCent Iy TestSigningCert 1/1/2040 <alls  MorehcBons b
Cal Te3TentCort TeiTeuCent 17172040 <Al

ProvateCertStare store contsins 3 certificates.

5.2.2.3 Windows driver without test mode

For Windows operating systems the driver has to be signed via "Attestation Signing". This requires an EV
certificate.

Microsoft provides relevant instructions: https://docs.microsoft.com/en-us/windows-hardware/drivers/
dashboard/attestation-signing-a-kernel-driver-for-public-release
The drivers created in this way are also suitable for devices that have secure boot enabled.

Microsoft announced that the previous procedure using CrossSigning certificates (signing tool with
parameter /ac) will be discontinued from July 2021. After this date it can no longer be used (depending on
the expiry date of the individual CrossSigning certificate), as documented here.

Versioned C++ projects [P 89], which are loaded via the TwinCAT Loader [»_54], have been available for
TwinCAT C++ for some time; they are not drivers for the purposes of the operating system. Beckhoff
therefore recommends using versioned C++ projects [»_89].

A guide is available in the How-to section [P 229] for the migration of TwinCAT C++ drivers to versioned C++
projects.
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6 Modules

The TwinCAT module concept is one of the core elements for the modularization of modern machines. This
chapter describes the modular concept and working with modules.

The modular concept applies to all TwinCAT modules, not just C++ modules, although most details only
relate to the engineering of C++ modules.

6.1 The TwinCAT Component Object Model (TcCOM)
concept

The TwinCAT Component Object Model defines the characteristics and the behavior of the modules. The
model derived from the "Component Object Model" COM from Microsoft Windows describes the way in
which various independently developed and compiled software components can co-operate with one
another. To make that possible, a precisely defined mode of behavior and the observation of interfaces of
the module must be defined, so that they can interact. Such an interface is also ideal for facilitating
interaction between modules from different manufacturers, for example.

To some degree TcCOM is based on COM (Component Object Model of the Microsoft Windows world),
although only a subset of COM is used. In comparison with COM, however, TcCOM contains additional
definitions that go beyond COM, for example the state machine module.

Overview and application of TcCOM modules

This introductory overview is intended to make the individual topics easier to understand.

One or several TcCOM modules are consolidated in a driver. This driver is created by TwinCAT Engineering
using the MSVC compiler. The modules and interfaces are described in a TMC (TwinCAT Module Class) file.
The drivers and their TMC file can now be exchanged and combined between the engineering systems.

TwinCAT XAR

TcCOM_1
Instance St,
Ty D

Driver
(*.sys)

Instance

Instances of these modules are now created using the engineering facility. They are associated with a TMI
file. The instances can be parameterized and linked with each other and with other modules to form the 10. A
corresponding configuration is transferred to the target system, where it is executed.

Corresponding modules are started, which register with the TwinCAT ObjectServer. The TwinCAT XAR also
provides the process images. Modules can query the TwinCAT ObjectServer for a reference to another
object with regard to a particular interface. If such a reference is available, the interface methods can be
called on the module instance.

The following sections substantiate the individual topics.
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ID Management

Different types of ID are used for the interaction of the modules with each other and also within the modules.
TcCOM uses GUIDs (128 bit) and 32 bit long integers.

TcCOM uses

* GUIDs for: ModullDs, ClassIDs and InterfacelDs.
« 32 bit long integers are used for: ParameterIDs, ObjectIDs, ContextlDs, CategoryID.

Interfaces
An important component of COM, and therefore of TcCOM too, is interfaces.

Interfaces define a set of methods that are combined in order to perform a certain task. An interface is
referenced with a unique ID (InterfacelD), which must never be modified as long as the interface does not
change. This ID enables modules to determine whether they can cooperate with other modules. At the same
time the development process can take place independently, if the interfaces are clearly defined.
Modifications of interfaces therefore lead to different IDs. The TcCOM concept is designed such that
InterfacelDs can superpose other (older) InterfacelDs ( "Hides" in the TMC description / TMC editor). In this
way, both versions of the interface are available, while on the other hand it is always clear which is the latest
InterfacelD. The same concept also exists for the data types.

TcCOM itself already defines a whole series of interfaces that are prescribed in some cases (e.qg.
ITComObiject), but are optional in most. Many interfaces only make sense in certain application areas. Other
interfaces are so general that they can often be re-used. Provision is made for customer-defined interfaces,
so that two third-party modules can interact with each other, for example.

« All interfaces are derived from the basic interface ItcUnknown which, like the corresponding interface of
COM, provides the basic services for querying other interfaces of the module (TcQuerylnterface) and
for controlling the lifetime of the module (TcAddRef and TcRelease).

» The ITComObiject interface, which must be implemented by each module, contains methods for
accessing the name, ObjectID, ObjectID of the parent, parameters and state machine of the module.

Several general interfaces are used by many modules:

* ITcCyclic is implemented by modules, which are called cyclically ("CycleUpdate"). The module can
register via the ITcCyclicCaller interface of a TwinCAT task to obtain cyclic calls.

» The ITcADI interface can be used to access data areas of a module.
» ITcWatchSource is implemented by default; it facilitates ADS device notifications and other features.

» The ITcTask interface, which is implemented by the tasks of the real-time system, provides information
about the cycle time, the priority and other task information.

» The ITComObjectServer interface is implemented by the ObjectServer and referenced by all modules.

A whole series of general interfaces has already been defined. General interfaces have the advantage that
their use supports the exchange and recycling of modules. User-defined interfaces should only be defined if
no suitable general interfaces are available.

Class Factories

"Class Factories" are used for creating modules in C++. All modules contained in a driver have a common
Class Factory. The Class Factory registers once with the ObjectServer and offers its services for the
development of certain module classes. The module classes are identified by the unique ClassID of the
module. When the ObjectServer requests a new module (based on the initialization data of the configurator
or through other modules at runtime), the module selects the right Class Factory based on the ClassID and
triggers creation of the module via its ITcClassFactory interface.

Module service life

Similar to COM, the service life of a module is determined via a reference counter (RefCounter). The
reference counter is incremented whenever a module interface is queried. The counter is decremented when
the interface is released. An interface is also queried when a module logs into the ObjectServer (the
ITComObiject interface), so that the reference counter is at least 1. The counter is decremented on logout.
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When the counter reaches 0, the module deletes itself automatically, usually after logout from the
ObjectServer. If another module already maintains a reference (has an interface pointer), the module
continues to exist, and the interface pointer remains valid, until this pointer is released.

TwinCAT XAR

TcCOM_1
Implements Interface

TcQuerylnterface

TcCOM _2

Interface Pointer
TcRelease

6.1.1 TwinCAT module properties

A TcCOM module has a number of formally defined, prescribed and optional properties. The properties are
sufficiently formalized to enable interchangeable application. Each module has a module description, which
describes the module properties. They are used for configuring the modules and their relationships with each
other.

If a module is instantiated in the TwinCAT runtime, it registers itself with a central system instance, the
ObjectServer. This makes it reachable and parameterizable for other modules and also for general tools.
Modules can be compiled independently and can therefore also be developed, tested and updated
independently. Modules can be very simple, e.g. they may only contain a basic function such as low-pass
filter. Or they may be very complex internally and contain the whole control system for a machine
subassembly.

There are a great many applications for modules; all tasks of an automation system can be specified in
modules. Accordingly, no distinction is made between modules, which primarily represent the basic functions
of an automation system, such as real-time tasks, fieldbus drivers or a PLC runtime system, and user- or
application-specific algorithms for controlling a machine unit.

The diagram below shows a common TwinCAT module with his main properties. The dark blue blocks define
prescribed properties, the light blue blocks optional properties.
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TwinCAT XAR

TwinCAT Module [TcCOM)]

Module Description
State Machine
TComObject Interface

Interface

Interfaces Parameters Pointars

Comtexts

Data Area

Data Areas Categories Pointers

ADS Port

Module description

-‘g.
B
i

e

S

State Machine

ITComDbject Interface

[sassER

Each TcCOM module has some general description parameters. These include a ClassID, which

unambiguously references the module class. It is instantiated by the corresponding ClassFactory. Each
module instance has an ObjectID, which is unique in the TwinCAT runtime. In addition there is a parent
ObjectID, which refers to a possible logical parent.

The description, state machine and parameters of the module described below can be reached via the
ITComObject interface (see "Interfaces").

Class description files (*.tmc)

The module classes are described in class description files (TwinCAT Module Class; *.tmc).

These files are used by developers to describe the module properties and interfaces, so that others can use
and embed the module. In addition to general information (vendor data, module class ID etc.), optional
module properties are described.
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» Supported categories

* Implemented interfaces

« Data areas with corresponding symbols
» Parameter

* Interface pointers

» Data pointers, which can be set

The system configurator uses the class description files mainly as a basis for the integration of a module
instance in the configuration, for specifying the parameters and for configuring the links with other modules.

They also include the description of all data types in the modules, which are then adopted by the configurator
in its general data type system. In this way, all interfaces of the TMC descriptions present in the system can
be used by all modules.

More complex configurations involving several modules can also be described in the class description files,
which are preconfigured and linked for a specific application. Accordingly, a module for a complex machine
unit, which internally consists of a number of submodules, can be defined and preconfigured as an entity
during the development phase.

Instance description files (*.tmi)

An instance of a certain module is described in the instance description file (TwinCAT Module Instance;
*.tmi). The instance descriptions are based on a similar format, although in contrast to the class description
files they already contain concrete specifications for the parameters, interface pointers etc. for the special
module instance within a project.

The instance description files are created by TwinCAT Engineering (XAE), when an instance of a class
description is created for a specific project. They are mainly used for the exchange of data between all tools
involved in the configuration. However, the instance descriptions can also be used cross-project, for example
if a specially parameterized module is to be used again in a new project.

State machine

State Machine

Each module contains a state machine, which describes the initialization state of the module and the means
with which this state can be modified from outside. The state machine describes the states, which occur
during starting and stopping of the module. This relates to module creation, parameterization and production
in conjunction with the other modules.

Application-specific states (e.g. of the fieldbus or driver) can be described in their own state machines. The
state machine of the TcCOM modules defines the states INIT, PREOP, SAFEOP and OP. Although the state
designations are the same as under EtherCAT fieldbus, the actual states differ. When the TcCOM module
implements a fieldbus driver for EtherCAT, it has two state machines (module and fieldbus state machine),
which are passed through sequentially. The module state machine must have reached the operating state
(OP) before the fieldbus state machine can start.

The state machine is described [P 44] in detail separately.
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Parameter

TwinCAT XAR

TwinCAT Module [TcCOM)

Module Description
State Machine
[TComObject Interface

nterface

erfaces ara ers -
Interface Parameters Pointers

Contexts

Data Area

Data Areas Categories i

ADS Port

Modules can have parameters, which can be read or written during initialization or later at runtime (OP
state). Each parameter is designated by a parameter ID. The uniqueness of the parameter ID can be global,
limited global or module-specific. Further details can be found in the "ID Management" section. In addition to
the parameter ID, the parameter contains the current data; the data type depends on the parameter and is
defined unambiguously for the respective parameter ID.

Interfaces

TwinCAT XAR

TwinCAT Module (TcCOM)
Module Description
State Machine

TComObject Interface
Interfaces Parameters
Contexts

Data Area
Pointers

Data Areas Categories

ADS Port
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Interfaces consist of a defined set of methods (functions), which offer modules through which they can be
contacted by other modules. Interfaces are characterized by a unique ID, as described above. A module
must support at least the ITComObiject interface and may in addition contain as many interfaces as required.
An interface reference can be queried by calling the method "TcQuerylnterface" with specification of the
corresponding interface ID.

Interface pointers

Interface
Pointers.

Interface pointers behave like the counterpart of interfaces. If a module wants to use an interface of another
module, it must have an interface pointer of the corresponding interface type and ensure that it points to the
other module. The methods of the other module can then be used.

Interface pointers are usually set on startup of the state machine. During the transition from INIT to PREOP
(IP), the module receives the object ID of the other modules with the corresponding interface; during the
transition from PREOP to SAFEOP (PS) or SAFEOP to OP (SO), the instance of the other modules is
searched with the ObjectServer, and the corresponding interface is set with the Method Query interface.
During the state transition in the opposite direction, i.e. from SAFEOP to PREOP (SP) or OP to SAFEOP
(OS), the interface must be enabled again.

Data areas

Data Areas

Modules can contain data areas, which can be used by the environment (e.g. by other modules or the 10
area of TwinCAT). These data areas can contain any data. They are often used for process image data
(inputs and outputs). The structure of the data areas is defined in the device description of the module. If a
module has data areas, which it wants to make accessible for other modules, it implements the ITcADI
interface to enable access to the data. Data areas can contain symbol information, which describes the
structure of the respective data area in more detail.
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Data area pointer

TwinCAT XAR

TWInCAT Module (TeCOM)

Interface
Painters

If a module wants to access the data area of other modules, it can contain data area pointers. These are
normally set during initialization of the state machine to data areas or data area sections of other modules.
The access is directly to the memory area, so that corresponding protection mechanisms for competing
access operations have to be implemented, if necessary. In many cases it is preferable to use a
corresponding interface.

Context

TwinCAT XAR

TwinCAT Module {TcCOM)
Module Description
State Machine
MComObject Interface

Interface

Interfaces Parameters : .
Pointers

Contexts

Data Area
Pointers

Data Areas Categories

ADS Port

The context should be regarded as real-time task context. Context is required for the configuration of the
modules, for example. Simple modules usually operate in a single time context, which therefore requires no
detailed specification. Other modules may partly be active in several contexts (e.g. an EtherCAT master can
support several independent real-time tasks, or a control loop can process control loops of the layer below in
another cycle time). If a module has more than one time-dependent context, this must be specified the in the
module description.
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Categories

TwinCAT XAR

TwinCAT Module {TcCOM)

Module Description
State Machine
MComObject Interface

Interface

Interfaces Parameters D
Pointers

Contexts

Data Area

Data Areas Categories :
= Pointers

ADS Port

Modules can offer categories by implementing the interface ITComObjectCategory. Categories are

enumerated by the ObjectServer, and objects, which use this to associated themselves with categories, can

be queried by the ObjectServer (ITComObjectEnumPtr).

ADS

TwinCAT XAR

TwinCAT Module {TcCOM)
Module Description
State Machine

MComObject interface

Interface
Pointers

interfaces Parameters

Contexis

Data Area

Each module that is entered in the ObjectServer can be reached via ADS. The ObjectServer uses the
ITComObject interface of the modules in order to read or write parameters or to access the state machine,

for example. In addition, a dedicated ADS port can be implemented, through which dedicated ADS

commands can be received.

TwinCAT 3 Version: 1.17

43



Modules BEGKHOFF

System module

In addition, the TwinCAT runtime provides a number of system modules, which make the basic runtime
services available for other modules. These system modules have a fixed, constant ObjectID, through which
the other modules can access it. An example for such a system module is the real-time system, which makes
the basic real-time system services, i.e. generation of real-time tasks, available via the ITcRTime interface.
The ADS router is also implemented as a system module, so that other modules can register their ADS port
here.

Creation of modules

Modules can be created both in C++ and in IEC 61131-3. The object-oriented extensions of the TwinCAT
PLC are used for this purpose. Modules from both worlds can interact via interfaces in the same way as pure
C++ modules. The object-oriented extension makes the same interfaces available as in C++.

The PLC modules also register via the ObjectServer and can therefore be reached through it. PLC modules
vary in terms of complexity. It makes no difference whether only a small filter module is generated or a
complete PLC program is packed into a module. Due to the automation, each PLC program is a module
within the meaning of TwinCAT modules. Each conventional PLC program is automatically packed into a
module and registers itself with the ObjectServer and one or several task modules. Access to the process
data of a PLC module (e.g. mapping with regard to a fieldbus driver) is also controlled via the defined data
areas and ITcADI.

This behavior remains transparent and invisible for PLC programmers, as long as they decide to explicitly
define parts of the PLC program as TwinCAT modules, so that they can be used with suitable flexibility.

6.1.2 TwinCAT module state machine

In addition to the states (INIT, PREOP, SAFEOP and OP), there are corresponding state transitions, within
which general or module-specific actions have to be executed or can be executed. The design of the state
machine is very simple. In any case, there are only transitions to the next or previous step.

This results in the state transitions: INIT to PREOP (IP), PREOP to SAFEOP (PS) and SAFEOP to OP (SO).
In the opposite direction, the following state transitions exist: OP to SAFEOP (OS), SAFEOP to PREOP (SP)
and PREORP to INIT (PI). Up to and including the SAFEOP state, all states and state transitions take place
within the non-real-time context. Only the transition from SAFEOP to OP, the OP state and the transition
from OP to SAFEOP take place in the real-time context. This differentiation is relevant when resources are
allocated or enabled, or when modules register or deregister with other modules.
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State: INIT

The INIT state is only a virtual state. Immediately after creation of a module, the module changes from INIT
to PREOP, i.e. the IP state transition is executed. The instantiation and the IP state transition always take
place together, so that the module never remains in INIT state. Only when the module is removed does it
remain in INIT state for a short time.

Transition: INIT to PREOP (IP)

During the IP state transition, the module registers with the ObjectServer with its unique ObjectID. The
initialization parameters, which are also allocated during object creation, are transferred to the module.
During this transition the module cannot establish connections to other modules, because it is not clear
whether the other modules already exist and are registered with the ObjectServer. When the module
requires system resources (e.g. memory), these can be allocated during the state transition. All allocated
resources have to be released again during the transition from PREOP to INIT (PI).

State: PREOP

In PREOP state, module creation is complete and the module is usually fully parameterized, even if further
parameters may be added during the transition from PREOP to SAFEOP. The module is registered in the
ObjectServer, although no connections with other modules have been created yet.

Transition: PREOP to SAFEOP (PS)

In this state transition the module can establish connections with other modules. To this end it has usually
received, among other things, ObjectIDs of other modules with the initialization data, which are now
converted to actual connections with these modules via the ObjectServer.

The transition can generally be triggered by the system according to the configurator, or by another module
(e.g. the parent module). During this state transition further parameters can be transferred. For example, the
parent module can transfer its own parameters to the child module.

State: SAFEOP

The module is still in the non-real-time context and is waiting to be switched to OP state by the system or by
other modules.
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Transition: SAFEOP to OP (SO)

The state transition from SAFEOP to OP, the state OP, and the transition from OP to SAFEOP take place in
the real-time context. System resources may no longer be allocated. On the other hand, resources can now
be requested by other modules, and modules can register with other modules, e.g. in order to obtain a cyclic
call during tasks.

This transition should not be used for long-running tasks. For example, file operations should be executed
during PS.

State: OP

In OP state the module starts working and is fully active in the meaning of the TwinCAT system.

Transition: OP to SAFEOP (OS)

This state transition takes place in the real-time context. All actions from the SO transition are reversed, and
all resources requested during the SO transition are released again.

Transition: SAFEOP to PREOP (SP)

All actions from the PS transition are reversed, and all resources requested during the PS transition are
released again.

Transition: PREOP to INIT (PI)

All actions from the IP transition are reversed, and all resources requested during the IP transition are
released again. The module signs off from the ObjectServer and usually deletes itself (see "Service life").

6.2 Module-to-module communication
TcCOM modules can communicate with one another. This article is intended to provide an overview of the
various options. There are four methods of module-to-module communication:

» 10 Mapping (linking of input/output symbols)

+ 10 Data Pointer

* Method calls via interface
« ADS

These four methods will now be described.

10 Mapping (linking of input/output symbols)

The inputs and outputs of TcCOM modules can be linked by 10 Mapping in the same way as the links to
physical symbols in the fieldbus level. To do this, data areas are created in the TMC editor [P_124] that
describe the corresponding inputs/outputs. These are then linked in the TwinCAT solution.

Through mapping, the data are provided or accepted at the task beginning (inputs) or task end (outputs)
respectively. The data consistency is ensured by synchronous or asynchronous mapping.

The implementing language (PLC, C++, Matlab) is unimportant.
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TwinCAT XAR

TcCOM TcCOM TcCOM
(PLC) (C++) (10}

Outputs Outputs Outputs

Nttt
m Mapping

The following sample shows the realization:

Sample12: Module communication: IO mapping used [ 296]

10 Data Pointer

Direct memory access is also possible within a task via the Data Area Pointers, which are created in the
TMC Editor.

If several callers of a task or callers from other tasks occur, the user must ensure the data consistency
through appropriate mechanisms. Data pointers are available for C++ and Matlab.

TwinCAT XAR

TcCOM

<

Outputs Outputs

The following sample shows the realization:

Sample10: Module communication: Use of data pointers [P 267]

Method calls via interfaces

As already described, TcCOM modules can offer interfaces that are also defined in the TMC editor. If a
module implements them (“Implemented Interfaces" in the TMC editor [»_116]), it offers appropriate methods.
A calling module will then have an "Interface Pointer" to this module in order to call the methods.

These are blocking calls, meaning that the caller blocks until the called methods come back and the return
values of the methods can thus be directly used. If several callers of a task or callers from other tasks occur,
the user must ensure the data consistency through appropriate mechanisms.

TwinCAT XAR

com —_()— Tccom
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The following samples show the realization:

Sample11: Module communication: PLC module calls a method of a C-module [P 268]

Sample11a: Module communication: C-module cites a method in the C-module [» 295]

Further samples exist for the communication with the PLC [» 315].

ADS

As the internal communication of the TwinCAT system in general, ADS can also be used to communicate
between modules. Communication in this case is acyclic, event-controlled communication.

At the same time ADS can also be used to collect or provide data from the UserMode and communicate with
other controllers (i.e. via the network). ADS can also be used to ensure data-consistent communication, e.g.
between tasks/cores/CPUs. In this case TcCOM modules can be both clients (requesters) and servers
(providers). The implementing language (PLC, C++, Matlab) is unimportant.

Windows Windows

OPC-UA HMI saL WET]]

"' ADS Router "’ ADS Router
y r A r

&+ i | 3 4

Matlab,/

Sl Simulink.

PLC CHt

TwinCAT TwinCAT

The following samples show the realization:

Sample03: C++ as ADS server [P 248]

Sample06: UI-C#-ADS client uploads the symbols from the module [» 258]

Sample07: reception of ADS notifications [P 263]

Sample08: provision of ADS-RPC [» 264]
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7 Modules - Handling

TcCOM modules are implemented and loaded after a build.
This section describes the handling of modules when they are exchanged between systems.
A distinction must be made between the two C++ project types:

« C++ drivers [P 49], which create a .sys file so that they can be loaded by the operating system.

* Versioned C++ projects [P 49] that create a tmx file to load them with the TwinCAT Loader [P 54]
(from TwinCAT 3.1 Build 4024).

Beckhoff recommends using versioned C++ projects [P 49] as standard. The advantages they offer include
the following:

 Driver signature [» 21] via OEM certificates that can be obtained from Beckhoff.
» Versioned storage [P_54] of the binaries.

* Online Change capability [»_155], if required.

71 Versioned C++ Projects

® From TwinCAT 3.1 Build 4024.0
1 The functionality described here is available from TwinCAT 3.1. 4024.0.

Versioned TwinCAT C++ projects result in an architecture-dependent TMX file during building and are
loaded via the TwinCAT Loader [»_54]. They must be signed by a TwinCAT user certificate.

If a C++ project was created using the template "Versioned C++ Project”, the binary files are stored by a
publish in the TwinCAT repository under C:\TwinCAT\3.x\Repository at a vendor- and version-specific
location.
From here required modules are transferred to the target system, if they are needed:

* Windows: C:\TwinCAT\3.1\Boot\Repository

« TwinCAT/BSD: /usr/local/etc/TwinCAT/3.1/Boot/Repository

This can be either at the time of activation (Activate Configuration) or at the time of the Online Change
[»_155].

Additionally, it is possible to create an archive for the transfer between engineering systems of the binary
version of this project, which is configured by the Tc Publish [»_150].

7.2 Non-versioned C++ projects

TwinCAT C++ drivers (.sys files) are loaded via the Windows operating system.
These are kernel-mode drivers which are subject to the normal requirements of the operating system with
regard to loading.

® Signing via Attestation Signing

1 Microsoft requires Attestation Signing for operating system drivers. Please familiarize your-self with
the procedure in advance.

Beckhoff recommends using versioned C++ projects that are loaded via the TwinCAT Loader.

If a C++ project has been created using the TwinCAT Driver Project template, the binary files are stored in
the TwinCAT folder under C:\TwinCAT\3.x\CustomConfig\Modules by a publish.

From here the driver is transferred to the target system under C:\TwinCAT\3.x\Driver if it is needed.
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Additionally, it is possible to create an archive for the transfer of the binary version of this project, which is
configured by theTc Publish [»_150].

Up to TwinCAT 3.1 4022.xx

Before Release 4024.0, the handling of the export and import functionality was somewhat different, which is
documented on the subpages.

Also see about this
Windows driver without test mode [ 34]

7.21 Export to TwinCAT 3.1 4022.xx

This article describes how to export a TwinCAT 3 driver that can run on any other TwinCAT PC.

The following steps have to be carried out

1. Implement a TwinCAT 3 C++ project on an engineering PC equipped with a Visual Studio version, see
quick start sample Create a TwinCAT 3 project [P _62]. Implement the TwinCAT modules as described,
compile and test the modules contained in the project before export.

2. Since the result should be able to be used on any machine, TwinCAT generates a 32-bit and a 64-bit
version.
Since x64 drivers must be signed, a certificate must be installed on the machine that exports the module.
See x64: Driver signing [»_20], how to generate and install a certificate.
(This step can be omitted on an engineering or 32-bit system)

3. To export a TC 3 C++ project, right-click on the module project in the solution tree and select TwinCAT
Publish Modules.

= The project is then compiled (rebuild) - the successful export is displayed in the Build output window.

Output

Show output from: |Euw|d '|| 3 | « E$| =% ‘ =

==========|TwinCAT Publish Modules started at @4.89.20812 12:11:23 ==========

Project "TempContr.vcxproj"™ (TcPublishModule target(s)):

Project "TempContr.vcxproj" (TcPublishModuleBinaries target(s)):

O\ TwinCAT3\SDK\\Bin\ExtractVersionInfo" "TempContr" "C:%\TwinCAT3\SDK\\_products\TwinCAT RT (x86)\Release‘\TempContri\TempContr"

:VCEnd

Could not open header file << C:\TwinCAT3\SDK\\_products\TwinCAT RT (x86)\Release\TempContr\\TempContrVersion.h 3!

c:WProgram Files (x86)\Microsoft Visual Studio 18.@\VCibiniCl.exe /c /IC:A\TwinCAT3A\SDK\\Include /IC:\TwinCAT3\SDK\\IncludeiIoc /IC:\TwinC
TcPch.cpp

c:WProgram Files (x86)\Microsoft Visual Studio 1@.@\VC\binWClL.exe /c /IC:%\TwinCAT3\SDK\\Include /IC:\TwinCAT3\SDK\\Include'Io /IC:\TwinC
TempContrClassFactory.cpp

TempContrDriver.cpp

TempContrDrv.cpp

C:%WProgram Files (x86)\Microsoft SDKs\Windows\v7.@A\bin\rc.exe /1"@x8483" /nologo /Fo"C:\TwinCAT3\SDK\\_products\TwinCAT RT (x86)%Releas

Please note the successful message at the end:
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Output

Show output from: |Bui|d '| | _ﬁ | "a'ﬂ E‘% | =X | =
TePch.cpp

c:%WProgram Files (x86)%\Microsoft Visual Studic 18.@°\VCO.binWCL.exe fc JIC:\TwinCAT3\5DK\%\Includ
TempContrClassFactory.cpp

TempContrltrl.cpp

TempContrDrv.cpp

TempContrW32.cpp

C:“\Program Files (x86)\Microsoft SDKs\Windows\v7.@&\binyrc.exe /D _UNICODE /D UNICODE /1"BxB848
c:%\Program Files (x86)\Microsoft Visual Studioc 1@.en\VC\binilink.exe JERRORREPORT:QUEUE /OUT:™C
"CATWinCATISDE Y _productsi\TwinCAT UM (x86)\Release\TempContr\TcPch.obj"

"CiATwinCAT3ASDKY \_products \TwinCAT UM (xB86)\Release\TempContriTempContrClassFactory.obj”
"CoATwinCAT3WSDEA_products \TwinCAT UM (x86)%\Release‘\TempContri\TempContrCtrl.obj"
"CoATwinCAT3WSDEN_products \TwinCAT UM (x86)%\Release\TempContri\TempContrDrv.obi"
"CoATwinCAT3WSDEN_products\TwinCAT UM (x86)%\Release\TempContriTempContri32.obj"

Creating library C:3\TwinCAT3%SDKA\_products \TwinCAT UM (x86)%Release‘\TempContrkW32.1lib and ol
TempContr.vcxproj -> CoA\TwinCAT345DKV_products)\TwinCAT UM (x86)%\Release\TempContri32.dll
C:"Program Files (x86)\Microsoft SDKs‘\Windowsw7.@A%bin\mt.exe /nologo fverbose Jout:™C:4TwinC
Done building project "TempContr.vcxproj™.

Project “TempContr.wcxproj™ (TcPublishAdditionalFiles target(s)):

Done building project "TempContr.vexproj™.

Done building project "TempContr.vexproj™.

========== TwinCAT Publish Modules finished at ©4.89.2812 12:11:29 ==========

The binary files and the TMC module description are exported to the TempContr folder under C:
\TwinCAT\3.x\CustomConfig\Modules.

4. For the import, simply copy the TempContr folder to any other TwinCAT 3 machine.

@U,| ;v Computer » O5(C:) » TwinCAT » 31 » CustomConfig » Modules » TestDriver »

Organize * Include in library + Share with - Burn Mew folder
MName 2 Date modified Type Size
TwinCAT RT (x64) 29.04.2014 10:14 File folder
, TwinCAT RT (x86) 29.04.2014 10:14 File folder
 TwinCAT UM (x54) 29042014 10:14 File folder
TwinCAT UM (x86) 29.04.2014 10:14 File folder
| 7| TestDrivertmc 29.04.2014 10:14 TMC File TKB
7.2.2 Import up to TwinCAT 3.1 4022.xx

This article describes how a TC3-C++ driver can be imported and integrated into a PC/IPC controller with
TwinCAT 3 XAE (without full version of Visual Studio).
The binary TC3-C++ driver was previously implemented and exported [»_50] on another PC.

The following steps have to be carried out
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1. Copy the TC3-C++ driver on the second IPC with TwinCAT XAE without the full version of Visual Studio
into the destination folder ..\TwinCAT\3.x\CustomConfig\Modules. The TestDriver.zip archive is
unpacked in this sample.

@l'\.../'l'| W v Computer » O50(C) » TwinCAT » 31 » CusternConfig » Modules »

Organize = & Open - Burn Mew folder
Mame . Date modified Type Size
. AdsCommunicationModule 04.11.2014 16:49 File folder
. IncrementerCpp 12.09.2014 08:40 File folder
| PublishDrrvertdod 01.09.2014 12:33 File folder
. SortCrder 05.09.2014 12:33 File folder
. TecDataTypeProvider 07.01.201511:58 File folder
. TcpClient 01.10.201512:34 File folder
. TempContr_Stateflow 29.04.201513:28 File folder
. Untitledl 01.06.2015 07:56 File folder
. VersionVendorlnfo 01.09.2014 12:54 File folder
| 1 TestDriver.zip 28.10.201514:23 Compressed (zipp... 2.606 KB

= The TestDriver (in the subfolders RT and UM) and the corresponding TwinCAT module Class *.tmc
file TestDriver.tmc are then available.

@Uv| W v Computer » O5(C) » TwinCAT » 31 » CustomConfig » Modules » TestDriver »

Organize = Include in library - Share with = Burn Mew folder
MName Date modified Type Size
. TwinCAT RT (x54) 29.04.2014 09:14 File folder
- TwinCAT RT (x86) 29.04.2014 09:14 File folder
) TwinCAT UM (x54) 29.04.2014 09:14 File folder
o TwinCAT UM (x36) 29.04.2014 09:14 File folder
| 7] TestDrivertrmc 29.04.2014 09:14 TMC File TKB

2. Start the TwinCAT XAE environment and create a TwinCAT 3 project.
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3. Right-click System->TcCOM Objects and select Add New Item....

Solution Explorer
@ o-=alp-
Search Solution Explorer (Ctrl+a)
& Solution TwinCAT I0-Project’ (1 project)
4 o] TwinCATIO-Project
4 ] SYSTEM
% License
@ Real-Time

& Tasks
sf= Routes
¥ Type System

MOTION
[ pLC
1] SAFETY
4 E C++
a Untitledl
I [ Untitledl Project

b Fro

- 1

o

] TcCOM Objects

Insert TeCom Object

Search:

Type:

File:

M arne: Object] [Clhcrementtdodule]

(1]8

[#-{8] Beckholf Automation GmbH

E| B8] C++ Module Vendor

B--@ C++ bodules

i i--[i] Clncrementtodule [Module]
i--Ji8| CModulel [Module]

[T CModulel [Module]

[ TE1400 Module Vendor

Cancel

7

Ak

=
£
=%
@

Ingert Instance..

Reload

C:ATwinCAT 3.1\ CustomConfightModuleshIncrementerCoptlncrementerCpp. tme

= The new CTestModule module is listed in the dialog box that appears.

4. Create a module instance by selecting the module name and continue with OK.
= The instance of the TestModule module now appears under TcCom Objects.

5. Create a new task.

6. Go to the context of the module instance and link the C++ module instance with the previously added

Task 1.
7. Activate the configuration.

7.3

Starting Modules

TwinCAT C++ modules can be started in two ways:

» Operating system: The operating system starts the TwinCAT module as a normal driver.
It is recommended to migrate to the TwinCAT Loader with TMX files.

e TwinCAT Loader: [P 54] The TwinCAT Loader starts the TwinCAT module.
o The TwinCAT Loader requires a signature [P_20] with TwinCAT user certificate.
o This option is mandatory for encrypted modules [P 57].

o The TwinCAT Loader is required for the versioned C++ projects [»_89].

TwinCAT 3

Version: 1.17
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Via System -> TcCOM Modules -> Class Factories tab you can see whether the TwinCAT Loader or the
operating system is used:

TwinCAT Projectl + > ||l SWasTs) Modulel h Solution Explorer
com@ o-2a| &=
Search Selution Explerer (Ctrl+ i)

| Online Objects | Project Db‘edg| Class Factories |

Class Factory | [l | TC Loader | Referenced by | 57 Solution TwinCAT Projectl L project)
co [ 4 5] TwinCAT Projectl
TCRTIME [~ 4[] SYSTEM
TCRTSOBJECTS [ |4 License
[ Untitledl I 2 TIXC*Untitled] “Untitled]_Objl (CModul... 7| . % i::l'('s“me

SAFETY
4 ﬂ C++
4 Untitledl
b [ Untitledl Project
b [E@] Untitledl_Objl (CModulel)
» F 1o

7.4 TwinCAT Loader

® From TwinCAT 3.1 Build 4024.0
1 The functionality described here is available from TwinCAT 3.1. 4024.0.

TwinCAT 3 has an integrated function for loading modules.
Modules loaded with the TwinCAT Loader:

* Must be signed: Test signing [»_54].

« Can be encrypted: Encrypting Modules [P 57], for which the TwinCAT Software Protection must be
configured with a User DB.

741 Test signing

The test signing for TwinCAT can be carried out with the same TwinCAT user certificate as for the actual
delivery (see Request TwinCAT 3 user certificate [P 24]).
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1. For test operation, e.g. during software development, the creation of a TwinCAT user certificate, as
described Creation of the Certificate Request file for TCO008 [P 25], is sufficient. Make sure that you

select the purpose "Sign TwinCAT C++ executable (*.tmx)". For this the Crypto version 2 is required, a
message appears.

are Frotection X

Certificates Database Users Groups Object Protection  Fights

MName Unique Status Issue (UTC) Expire (UTC) Permissions
Create OEM Certificate *
OEM Mame: il
. | ; ] ] | Cancel
OEM Certfficatt  Unique Mame [domain or e-mail address):
Create New.] | |
Import ... ] Certifizate for:

Sign user DB
Sign OEM licensze request
OEM Authaority Sign TwinCAT C++ executable [* )

Sign License

Create Temp*

Creste How q e Vel Microsoft Visual Studio

Reissue E:rjst‘

OEM certificate for TwinCAT C++ executable signing must use crypto
version 2 which is supported by TwinCAT 3.1.4024 and newer, Change
crypto version?

oK | Cancel

On XAR (and XAE, ifitis a local test), activate the test mode so that the operating system can accept the
self-signed certificates. This can be done on both engineering systems (XAE) and runtime systems (XAR).

For Windows

Use the administrator prompt to execute the following:

bcdedit /set testsigning yes

and reboot the target system.

You may have to switch off "SecureBoot" for this, which can be done in the bios.

If test signing mode is enabled, this is displayed at the bottom right of the desktop. The system now accepts
all signed drivers for execution.

Test Mode
Windows 10 Enterprise

Build 19041.vb_release.191206-1406
10:55 AM
10/15/2021
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For TwinCAT/BSD

In the file /usr/local/etc/TwinCAT/3.1/TcRegistry.xml enter ,<Value
Name="EnableTestSigning" Type="DW">1</Value>"under Key "System".
<Key Name="System">

<Value Name="RunAsDevice" Type="DW">1</Value>

<Value Name="RTimeMode" Type="DW">0</Value>

<Value Name="AmsNetId" Type="BIN">052445B00101</Value>

<Value Name="LockedMemSize" Type="DW">33554432</Value>

<Value Name="EnableTestSigning" Type="DW">1</Value>
</Key>

Then restart the TwinCAT System Service:
doas service TcSystemService restart

After the respective procedure, the system accepts all signed drivers for execution.

2. During the first activation (Activate Configuration) with a TwinCAT user certificate, the target system
detects that the certificate is not trusted and the activation process is aborted:

Error List
Entire Solution - ||@ 2 Errors H| 1 4Warnings |||0 18 Messages H Clear | | Build + IntelliSense -
Code  Description
) 27.08.2019 17:32:42 783 ms | "TwinCAT System' (10000): Sending ams command »> InitT\Load Driver: Load Versioned Classfactory 'C++ Module Vendor|Untitled1]0.0.0.1" = » AdsError:
ERROR: General ADS Error) << failed!
[x] 27.08.2019 17:32:42 782 ms | 'TCOM Server' (10): Loading 'CA\TwinCAT\3.1\Boot\Repositon\ C++ Module Vendor\Untitled 140.0.0.1\Untitled1.trmx' failed
27.08.2019 17:32:42 782 ms | TCOM Ek’ver' (10 Impert 'C\TwinCAT\3. 1\ Target\OemCertificates\test.domain_db006e5e-e160-0177-d83e-2f0ddafdacfe.reg’ to add OEM to trusted list
For Windows:
A local user with administration rights can trust the certificate via the created REG file by simply
executing it:

» ThisPC » Systern (C:) » TwinCAT » 3.1 » Target » OemCertificates

[ Mame Date modified Type Size

@ test.domain_db006e5e-e160-0177-d83e-2... 27.08.201917:32 Registration Entries 2 KB

o The keys and values contained in
CATwinCAT\3. T\ Target\ QemCertif...\test. domain_db006e3e-e160-0177-d33e-2f0d dafdaefe.reg
have been successfully added to the registry.

For TwinCAT/BSD:
If the "Tcimportcert" package is not installed, install it: pkg install tcimportcert
Trust the certificate via doas tcimportcert /usr/local/etc/TwinCAT/3.1/Target/
OemCertificates/<CreatedFile>.reg
Then restart the TwinCAT System Service or reboot the system:
doas service TcSystemService restart
= This process only enables C++ modules with a signature from the trusted TwinCAT user certificates
to run.

3. Following this process you can use the TwinCAT user certificate for signing with the test mode of the
operating system.
This is configured in the project properties [P_151].
Use the TcSignTool [P 59] to avoid storing the password of the TwinCAT user certificate in the project,
where it would also end up in version management, for example.

If you want to use the TwinCAT user certificate without TestMode for delivery, you must have the certificate
countersigned by Beckhoff [»_24].
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7.4.2 Encrypting Modules

TwinCAT C++ modules loaded via the TwinCAT Loader (TMX files) can be encrypted, i.e. a key protects the
content of the driver against manipulation and reverse engineering at file level.

® Nodebugging

Encrypted modules cannot be searched for errors. Encrypted modules are not displayed in the de-
bugger.

Module encryption is enabled as follows:
v' The TwinCAT software protection must be configured.
v" A TwinCAT user certificate with Sign UserDB rights is required.
1. In the system tree, select the Solution User DB Key as the Boot File Encryption Key.

TwinCAT Project2 + > [R5 TS M7 Maodulel.h ~ | Solution Explorer
-
| Genercl|| Settings | Data Types I Interfaces | Fundions| @ | e - a | '
. Search Solution Explorer (Ctrl+ )
Boot Settings Lpply
Auto Boot: (©) Run Mode (Enable) fa] Solution ‘TwinCAT Project2' (1 project)
© Corfig Mode 4 [3] TwinCAT Project2
4 ({1 SYSTEM
Auto Logon O ¥ License
User Name @ Real-Time
Password 4 BB Tesks
& Task1
) =f= Routes
Boot File Encryption @ TcCOM Objects
Encryption Key: I[User DB Key - MOTION
PLC
(0 SAFETY
4 ’E C++

2. Select the C++ project and activate encryption there:

TwinCAT Project2 = > [RGEIEEST

Maodulel .h ~ | Solution Explorer

Project a | © - g -
Search Solution Explorer (Ctrl+d)
Project Name: Untitled 1 ld: 1 - : - i
] Solution 'TwinCAT Project2' (1 project)
Project Path: Untitled1 4 a TwinCAT Project2

4 SYSTEM
¥ License
@ Real-Time
4 % Tasks
[ Taskl
=iz Routes
[&] TcCOM Objects
MOTION
PLC
(| SAFETY

r 1
‘i Untitled]
1l Project

4 @ Untitledl_Objl (CModulel)

Project Type: C++ Project
Project Guid: {4D1A261D-8D02-4BCE-A4D4-738CTD1B3CAZ}

Encryption: [Enc:)fpt boot project -

Comment:

3 Inputs
b [ Outputs
b EFro

3. To start, an encrypted module must be loaded with the TwinCAT Loader (not the operating system).

= For non-versioned drivers: The drivers are encrypted during transfer to the _deployment directory of the
project.

= For versioned TMX: The drivers are stored unencrypted in XAE and encrypted when they are activated
on the target system.

= If the function is used with versioned C++ projects, the TMX files are stored in the repository [P 49] as
usual.

TwinCAT C++ modules can be started in two ways:

» Operating system: The operating system starts the TwinCAT module as a normal driver.
It is recommended to migrate to the TwinCAT Loader with TMX files.
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e TwinCAT Loader: [P 54] The TwinCAT Loader starts the TwinCAT module.
o The TwinCAT Loader requires a signature [P 20] with TwinCAT user certificate.
o This option is mandatory for encrypted modules [P 57].

o The TwinCAT Loader is required for the versioned C++ projects [»_89].

Via System -> TcCOM Modules -> Class Factories tab you can see whether the TwinCAT Loader or the

operating system is used:

TwinCAT Projectl + > [[Rlf i 5T

[ Online Objects | Project Objects | Class Factories |

Modulel.h

Class Factory | (e | TC Loader | Referenced by |
TCIo Il
TCRTIME ¥
TCRTSOBIECTS Fdl
[ Untitledl I [» TIXC*Untitled] *Untitled]_Objl (CModul... 7|

7.4.3

Return Codes

Loading a module with the TwinCAT Loader can fail for various reasons.

Return codes under Windows

Solution Explorer

e oM & o=
Search Selution Explerer (Ctrl+ i)
] Solution 'TwinCAT Projectl’ (1 project)
4 2] TwinCAT Projectl
4 |40 SYSTEM
¥ License
@ Real-Time
4 % Tasks
[Br Taskl

[&] TcCOM Objects
e SIReI

cRa -]

4 Untitledl
P [& Untitledl Project

4 @ Untitledl_Objl (CModulel)
v E o

Hex Description

0xC1 File is corrupted; PE file checksum error.

0x241 Signing error: TwinCAT user certificate does not match the file hash.
0x4FB Signing error: File not signed.

0x1772 File is encrypted, but cannot be decoded with known keys.
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Return codes under TwinCAT/BSD

Hex Description

0xC0000001 File is corrupted; PE file checksum error.

0xC0000004

0xC000007B

0xC0000173

0xC0000221

0xC0000102 Signing error: TwWinCAT user certificate does not match the file hash.

0xC0000424

0x4FB Signing error: File not signed.

0xC0000428 Signing error: Used certificate not countersigned. Test mode necessary.

0xC0000603 Signing error: Certificate is not trusted. Add necessary (see "tcinsertcert")

0xC0000385 Signing error: File not signed. Check the settings in Engineering.

0xC0000293 File is encrypted, but cannot be decoded with known keys.

0xC0000225 File not found.

7.4.4 TcSignTool - Storage of the certificate password outside the
project

The TcSignTool can be used to store a password for a TwinCAT user certificate in the registry. Thus, the
password is not needed in the projects, where the passwords would end up unintentionally in version control
systems.

The TcSignTool is a command line program located in the path C:\TwinCAT\3.x\sdk\Bin\.

The storage of the password is carried out with the following parameters:

tcsigntool grant /f "C:\TwinCAT\3.1l\CustomConfig\Certificates\MyCertificate.tccert" /p MyPassword

The password is deleted with the following parameters:

tcsigntool grant /f "C:\TwinCAT\3.1\CustomConfig\Certificates\MyCertificate.tccert" /r

The unencrypted password is stored under HKEY CURRENT USER\SOFTWARE\Beckhoff\TcSignTool\
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8 TwinCAT C++ development

Overview of the development environment

D¢ TwinCAT 10-Project - Microsoft Visual Studio (Administrator) X & | QuickLaunch (¢
File Edit  View Project Build Debug  TwinCAT  TwinSAFE  PLC  Team Tools Test Scope  Analyze  Window  Help

fe-o|B-m-2 | - -] Release ~ TwinCAT RT (x64) ~ B TwinCAT Debugger - 3 7 AddMod -
e il | S || <Local> = = -

Solution Explorer * & X Modulel.cpp & X
@ o-sam &= Untitled] -1 2 CModulel +|® CycleUpdate[TTcTask * ipTask, ITcUnknow -
{ - £
Search Solution Explorer (Ctrl+ () L~ ‘:

HRESULT hr = S_OK;
a1 Solution TwinCAT [O-Praject’ (1 project) m_Trace.Log{tlVerbose, FENTERA};

4 ol TwinCAT [O-Project

4 (] svYSTEM 1 2 // TODD: Add deinitialization code
'
. LI(EHS.E m_Trace.Log{tlVerbose, FLEAVEA "hr=8x%238x", hr};
@ Real-Time return hr;
B Tasks T
== Routes

11

¥n Type System
EHRESULT CModulel::CycleUpdate(ITcTask* ipTask, ITcUnknown* ipCaller, ULONG_PTR context)

[&] TcCOM Objects

MOTION HRESULT hr = 5_OK;
O PLC
(43 SAFETY // TODO: Replace the sample with your cyclic code
4 E Ct++ m_counter+=m_Inputs.Value; _

m_Outputs.Value=m_counter;

a Untitled1
4 [%] Untitledl Project
P =B References
b 5 Exernal Dependencies
Header Files
Source Files

return hr;

ko
Fl

-

++ Modulel.cpp
++ TcPch.cpp
[ Untitledl.re Show output from: Build
++ Untitledl ClassFactory.cpp 13 -
4 TMC Files 1> Number of errors: @

TwinCAT RT Files
3 TwinCAT UM Files

P E Vo

Solution Explorer

ag 4

Exception Settings  Error List ﬂ !ﬂl

Team Explorer

The layout of Visual Studio is flexible and adaptable, so that only a brief overview of a common configuration
can be provided here. The user is free to configure windows and arrangements as required.

1. In the TwinCAT solution, a TwinCAT C++ project can be created by right-clicking on the C++ icon.
This project contains the sources (“Untitled Project”) of perhaps several modules [»_35], and module
instances ("Untitled1_Obj1 (CModule1)") can be created. The module instances have inputs/outputs,
which can be linked in the usual way ("Link"). There are further options [P 46] for module interaction.

2. The Visual Studio editor for Visual C++ is used for programming. Note in particular the drop-down
boxes for fast navigation within a file. In the lower section the result of the compile process is output.

The user can switch to TwinCAT messages (cf. Module messages for the Engineering (logging / trac-

ing) [» 219]).
The usual features such as breakpoints (cf. Debugging [» 81]) can be used in the editors.

3. The freely configurable toolbar usually contains the toolbar for TwWinCAT XAE Base. Activate Config-
uration, RUN, CONFIG, Choose Target System (in this case <Local>) and several other buttons pro-
vide fast access to frequently used functions. The TwinCAT Debugger is the button for establishing a
connection to the target system with regard to C++ modules (the PLC uses an independent debug-
ger). Like in other C++ programs, and in contrast to PLC, in TwinCAT C++ a distinction has to be
made between "Release" and "Debug". In a build process for "Release", the code is optimized to such
an extent that a debugger may no longer reliably reach the breakpoints, and incorrect data may be
displayed.

Procedure
This section describes the processes for programming, compiling and starting a TwinCAT C++ project.

It provides a general overview of the engineering process for TwinCAT C++ projects with reference to the
corresponding detailed documentation. The quick start [P_62] guide describes the individual common steps.
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1. Type declaration and module type:
The TwinCAT Module Class Editor (TMC) [P 93] and TMC code generator is used for the definition of
data types and interfaces, and also for the modules that use these.
The TMC code generator generates source code based on the processed TMC file and prepares data
types / interfaces for use in other projects (like PLC).
Editing and starting the code generator can take place as often as you like — the code generation pays
attention to programmed user code and saves it.

2. Programming
The familiar Visual Studio C++ programming environment is used for the development and debugging
[»_81] of the user-defined code within the code template.

3. Instantiating modules [» 35]
The program describes a class, which is instantiated as objects. The TwinCAT Module Instance
Configurator [P_136] is used for configuring the instance. General configuration elements are: assign
task, download symbol information for runtime (TwinCAT Module Instance (TMI) file) or define
parameter/interface pointer.

4. Mapping of variables
The input and output variables of an object can be linked with variables of other objects or PLC projects,
using the standard TwinCAT System Manager.

5. Building
During the building (compilation and linking) of the TwinCAT C++ project, all components are compiled
for the selected platform. The platform is determined automatically when the target system is selected.

6. Publishing (see Export to TwinCAT 3.1 4022.xx [»_50] / Import up to TwinCAT 3.1 4022.xx [ _51])
During publishing of a module, the drivers for all platforms are created, and the module is prepared for
distribution. The created directory can be distributed without the need to transfer the source code. Only
binary code with the interface description is transferred.

7. Signature (see Driver signing [»_20])

The TwinCAT drivers must be signed for x64 run times, since 64-bit Windows versions require that
kernel modules are signed. Therefore, this applies both to the x64 creation and to the publication of
modules, because these modules contain the x64 binary codes (if not deactivated).

The signature process can be user-defined [P _34].

8. Activation
The TwinCAT C++ driver can be activated like any other TwinCAT project via Activate Configuration.
The dialog then requests to switch TwinCAT to RUN mode.
Debugging [»_81] in real-time (which is familiar from IEC61131-based systems) and the setting of
(conditional) breakpoints is possible for TwinCAT C++ modules.

= The module runs under real-time conditions.
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9 Quick Start

This quick start shows how you can familiarize yourself with the TwinCAT C++ module engineering in a short
time. Each step in the creation of a module that runs in a real-time context is described in detail.

Two different scenarios are discussed:

« TwinCAT versioned C++ projects, which are recommended for new projects from 4024.0 or higher.
Modules based on such project are loaded by TwinCAT and stored versioned in binary form.

» We illustrate how to switch between the different versions via Online Change, using versioned C++
projects as a basis.

Before the quick start, please pay attention to the preparation - just once! In particular, prepare the
respective driver signing.

9.1 Create TwinCAT 3 project

Start the TwinCAT Engineering Environment (XAE)

Microsoft Visual Studio can be started via the TwinCAT SysTray icon.

@® About TwinCAT...

(] TwinCAT XAE (TcXaeShell)
B TwinCAT XAE (VS 2019)
Tools 4

.;::5‘ Realtime Settings...
¢  Router »

System »

The Visual Studio versions recognized during the installation and supported by TwinCAT are thereby offered.
Alternatively, Visual Studio can also be started via the Start menu.

Creating a TwinCAT 3 C+ + project

Carry out the following steps to create a TwinCAT C++ project:
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1. Select New TwinCAT Project ... via the Start page.

Create a neW project Search for templates (Alt+S) P~

Recent project temp|ates All languages - All platforms - All project types -

Vi | Basi Wind Deskt Lib!
[l TwinCAT XAE Project (XML format) L ncowsy Ehesiony DR,

n "‘!" Dynamic-Link Library with exports (DLL)
&%

Bl Console Application c# Build a .dll that can be shared between multiple running Windows apps.
B Empty TwinCAT Controller Project a TwinCAT XAE Project (XML format)
TwinCAT XAE System Manager Configuration
{1l TwinCATPLC Project
TwinCAT PLC System Manager Configuration
h E Filter Designer Project
Creates a new Measurement Project with a new Filter Designer Project

Not finding what you're looking for?
Install more tools and features

2. Alternatively, you can create a project by clicking on: File -> New -> Project.
= All existing project templates are displayed.

3. Select TwinCAT XAE Project and optionally enter a suitable project name.

4. Click OK.

Configure your new project

TwinCAT XAE Project (XML format)

Project name

‘ TwinCAT Project1

Location

CA\ -
Solution

Create new solution -
Solution name @

TwinCAT Project1

[ Place solution and project in the same directory
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= The Visual Studio Solution Explorer then displays the TwinCAT 3 project.

Solution Bxplorer
@8 o-28 F=]
Search Solution Explorer (Cirl+ G -

&) Solution TwinCAT Project]’ (1 of 1 project)
4 ol TwinCAT Project]
bl SYSTEM
= MOTION
B rLc
i sareTy
[

il AMALYTICS

¢ B vo

9.2 Create TwinCAT 3 C++ project

After creating a TwinCAT 3 project, open the C++ node and proceed as follows:

1. Right-click C++ and choose Add New Item....
If the green C++ symbol is not listed, this means that either a target device is selected that doesn't
support TwinCAT C++ or the TwinCAT Solution is currently open in a version of Visual Studio that is not

C++-capable (cf. Requirements [»_19]).

Solution Explorer * 0 X
Q8 o-28 pl=
Search Solution Explorer (Ctrl+d) 2~

fa] Sclution “TwinCAT Project!’ (1 of 1 project)
F] hi TwinCAT Project]
b @l SYSTEM
=l MOTION

PLC

i SAFETY

ﬂANAI 1°*|:| Add Mew ltem... Ins
b Evo 'O AddEfsting ltem... Shift+Alt+ A

Hide C++ Configuration

= The TwinCAT C++ Project Wizard [P_89] is shown and all existing project templates are listed.

2. A) Select TwinCAT Versioned C++ Project, optionally enter a related project name and click on OK.
B) Alternatively use the TwinCAT Static Library Project, which provides an environment for

programming static TC-C++ libraries (see Sample 25 [»_307]).
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C) TwinCAT Driver Project are still offered for compatibility reasons, but should no longer be used for
new projects.

Add New Item - TwinCAT Project1 ? X
4 |nstalled Sort by: Default d Search (Ctrl+E) P~
TwinCAT C++ Project g TwinCAT Versioned G+ Project TwinCAT C++ Project Type: TwinCAT C++ Project

b Online Cvea_tes a TwinCAT C++ prgject with

ﬂ TwinCAT Driver Project TwinCAT C++ Project esioned das,s factor)_r EuchisURpOts

deployment via repository.

E TwinCAT Static Library Project TwinCAT C++ Project
Name: Untitled1
Location: C\ v

[ add || cancel

= The TwinCAT Module wizard [» 90] is displayed.
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3. In this case, select TwinCAT Module Class with Cyclic I/O and click on OK. If you want to use the
OnlineChange capability, select the TwinCAT Module Class Online Changeable.

A name is not necessary and also cannot be entered here.

Add New ltem - Untitled1

4 |nstalled

PN TwinCAT C++ Module

Motion

P Online

v
=}
-+
o

=

. Default -

TwinCAT Module Class

TwinCAT Module Class with ADS port
TwinCAT Module Class for Unit Testing
TwinCAT Module Class with Cyclic Caller
TwinCAT Module Class with Cyclic 10
TwinCAT Module Class with Data Pointer
TwinCAT Module Class for RT Context

TwinCAT Module Class Online Changeable

TwinCAT C++ Module

TwinCAT C++ Module

TwinCAT C++ Module

TwinCAT C++ Module

TwinCAT C++ Module

TwinCAT C++ Module

TwinCAT C++ Module

TwinCAT C++ Module

L\)O

Search (Ctrl+E) peois

Type: TwinCAT C++ Module

Creates a new TwinCAT module class.

Add Cancel
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4. Enter a unique name in the TwinCAT Class Wizard dialog box or continue with the "Module1"
suggestion.

TwinCAT Class Wizard x
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= A TwinCAT 3 C++ project will then be created on the basis of the selected template:

Solution Explorer

@8 o-2 8B o s

Search Salution Explorer (Ctri+ 0 Fei
2] Solution “TwinCAT Project1’ (1 of 1 project)
4 gl TwinCAT Project

> @l SYSTEM
= MOoTION
g rLc
i) SAFETY
F E Cos
4[] Untitled!
4[] Untitled1 Project
b =8 References
b GV External Dependencies
4 yi Header Files

[@ TcPch.h
[}0

[® Untitled1ClassFactory.h

[ Untitledlinterfaces.h

[ Untitled1Services.h
4w/ Source Files

++ Modulel.cpp

++ TcPch.cpp

ED Untitled1.rc
*+ Untitled1ClassFactory.cpp

B 2 TMC Files

b ¥ TwinCAT OS Files

b ¥ TwinCATRT Files

b 2 TwinCAT UM Files

&l anavmcs
b Vo
9.3 TwinCAT 3 C++ Configure project

v You have created a TwinCAT Versioned C++ project and also had a module created by the wizard

1. Go to the properties of the project by right-clicking.
2. Activate the TwinCAT Signing in the Tc Sign tab.

3. If you have not yet created a TwinCAT user certificate, follow the instructions and observe to select the

Sign TwinCAT C